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1
Introduction
This topic provides information on:

• Installing Dell OpenManage Server Administrator (OMSA) on managed systems.

• Installing and using the Remote Enablement feature.

• Managing remote systems using OpenManage Server Administrator Web Server.

• Configuring the system before and during a deployment or upgrade.

NOTE: If you are installing management station and managed system software on the same system, install identical 
software versions to avoid system conflicts.

Dell OpenManage Systems Management Software
Dell OpenManage systems management software is a suite of applications that enables you to manage the Dell systems 
with proactive monitoring, notification, and remote access.

Dell OpenManage systems management software comprises of two DVDs:

• Dell Systems Management Tools and Documentation
• Dell OpenManage Server Update Utility

NOTE: For more information on these DVDs, see Dell OpenManage Management Station Software Installation 
Guide at support.dell.com/manuals.

Server Administrator Components on a Managed System

The setup program provides the following options:

• Custom Setup

• Typical Setup

The custom setup option enables you to select the software components you want to install. The Managed System 
Software Components table lists the various managed system software components that you can install during a custom 
installation.

Table 1. Managed System Software Components

Component What is installed Deployment Scenario Systems to install on

Server Administrator Web 
Server

Web-based system's 
management functionality 
that enables you to manage 
systems locally or remotely

Install only if you want to 
remotely monitor the 
managed system. You need 
not have physical access to 
the managed system.

Any system. For example, 
laptops, desktops, or Dell 
PowerEdge systems.

Server Instrumentation Server Administrator CLI 
and Instrumentation Service

Install to use the system as 
the managed system. 
Installing Server 

Supported Dell PowerEdge 
systems. For a list of 
supported Dell PowerEdge 
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Component What is installed Deployment Scenario Systems to install on

Instrumentation and the 
Server Administrator Web 
Server installs Server 
Administrator. Use Server 
Administrator to monitor, 
configure, and manage the 
system.

NOTE: If you choose to 
install only Server 
Instrumentation (without 
selecting Remote 
Enablement), you must 
also install the Server 
Administrator Web 
Server.

systems, see the Dell 
Systems Software Support 
Matrix at support.dell.com/
manuals.

Storage Management Server Administrator 
Storage Managementthe

Install to implement 
hardware RAID solutions 
and configure the storage 
components attached to the 
system. For more 
information on Storage 
Management, see the Dell 
OpenManage Server 
Administrator Storage 
Management User’s Guide 
in the docs directory or at 
support.dell.com/manuals.

Only those systems on 
which you have installed 
Server Instrumentation or 
Remote Enablement.

Remote Enablement Server Administrator CLI 
and Instrumentation Service 
and CIM Provider

Install to perform remote 
systems management tasks. 
Install Remote Enablement 
on the system and install 
only the Server 
Administrator Web Server 
on another system (say, 
system X). Now use system 
X to remotely monitor and 
manage the system. Use 
system X to manage any 
number of systems on 
which Remote Enablement 
is installed.

Supported Dell PowerEdge 
systems. For a list of 
supported Dell PowerEdge 
systems, see the Dell 
Systems Software Support 
Matrix at support.dell.com/
manuals.

Remote Access Controller Server Administrator CLI 
and Instrumentation Service 
and iDRAC or DRAC 5, or 
DRAC 4 (depending on the 
type of the Dell PowerEdge 
system)

Install to receive e-mail 
alerts for warnings or errors 
related to voltage, 
temperature, and fan speed. 
Remote Access Controller 
also logs event data and the 
most recent crash screen 
(available only on systems 
running Microsoft Windows 
operating system) to help 

Only those systems on 
which you have installed 
Server Instrumentation or 
Remote Enablement.
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Component What is installed Deployment Scenario Systems to install on

you diagnose the probable 
cause of a system crash.

Intel SNMP Agent Intel Simple Network 
Management Protocol 
(SNMP) Agent

Install to enable Server 
Administrator to obtain 
information about Network 
Interface Cards (NICs).

Only on Dell PowerEdge 
systems on which Server 
Instrumentation is installed 
and which are running on 
Microsoft Windows 
operating system.

Broadcom SNMP Agent Broadcom SNMP Agent Install to enable Server 
Administrator to obtain 
information about NICs.

Only on Dell PowerEdge 
systems on which Server 
Instrumentation is installed 
and which are running on 
Microsoft Windows 
operating system.

Related Links:

Custom Installation

Security Features
Dell OpenManage systems management software components provide these security features:

• Authentication for users from Operating System with different privilege levels, or by using the optional Microsoft 
Active Directory.

• Support for Network Information Services (NIS), Winbind, Kerberos, and Lightweight Directory Access Protocol 
(LDAP) authentication protocols for Linux operating systems.

• Role-based authority that allows specific privileges to be configured for each user.

NOTE: Applicable only for systems running Red Hat Enterprise Linux or SUSE Linux Enterprise Server or VMware 
ESX/ESXi.

• User ID and password configuration through the web-based interface or the command line interface (CLI), in 
most cases.

• SSL encryption (Auto Negotiate and 128-bit or higher.)

NOTE: Telnet does not support SSL encryption.

• Session time-out configuration (in minutes) through the web-based interface.
• Port configuration to allow Dell OpenManage systems management software to connect to a remote device 

through firewalls.

NOTE: For information about ports that the various Dell OpenManage systems management components use, see 
the User Guide for that component.

For information about the Security Management, see the Dell OpenManage Server Administrator User’s Guide at 
support.dell.com/manuals.

Other Documents You Might Need
In addition to this guide, access the following guides available on the Dell Systems Management Tools and 
Documentation DVD or at support.dell.com/manuals. On the Manuals page, click Software → Systems Management. 
Click the appropriate product link on the right-side to access the documents.
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• The Dell Lifecycle Controller 2 Version 1.00.00 User's Guide provides information on using the Lifecycle 
Controller.

• The Dell Management Console User’s Guide provides information about installing, configuring, and using Dell 
Management Console.

• The Dell Systems Build and Update Utility User’s Guide provides information on using the Systems Build and 
Update Utility.

• The Dell Systems Software Support Matrix provides information about the various Dell systems, the operating 
systems supported by these systems, and the Dell OpenManage components that can be installed on these 
systems.

• The Dell OpenManage Server Administrator User's Guide describes the installation and use of Server 
Administrator.

• The Dell OpenManage Server Administrator SNMP Reference Guide documents the SNMP management 
information base (MIB.)

• The Dell OpenManage Server Administrator CIM Reference Guide documents the Common Information Model 
(CIM) provider, which is an extension of the standard management object format (MOF) file. This guide explains 
the supported classes of management objects.

• The Dell OpenManage Server Administrator Messages Reference Guide lists the messages that are displayed 
on the Server Administrator home page Alert log, or on the operating system’s event viewer. This guide explains 
the text, severity, and cause of each alert message that the Server Administrator displays.

• The Dell OpenManage Server Administrator Command Line Interface Guide documents the complete command 
line interface for Server Administrator, including an explanation of CLI commands to view system status, access 
logs, create reports, configure various component parameters, and set critical thresholds.

• The Dell OpenManage IT Assistant User’s Guide has information about installing, configuring, and using the IT 
Assistant.

• The Dell Remote Access Controller 5 User’s Guide provides complete information about installing and 
configuring a DRAC 5 controller and using DRAC 5 to remotely access an inoperable system.

• The Integrated Dell Remote Access Controller User's Guide provides complete information about configuring 
and using an integrated Dell Remote Access Controller to remotely manage and monitor the system and its 
shared resources through a network.

• The Dell Update Packages User's Guide provides information about obtaining and using the Dell Update 
Packages for Windows and Linux as part of the system update strategy.

• The Dell OpenManage Server Update Utility User's Guide provides information on using the Dell OpenManage 
Server Update Utility.

• The Dell Systems Management Tools and Documentation DVD contains readme files for applications found on 
the media.

NOTE: If the product does not perform as expected or you do not understand a procedure described in this guide, 
see Getting Help in the system’s Hardware Owner’s Manual .

Getting Technical Assistance
NOTE: If you do not have an active Internet connection, you can find contact information on the purchase invoice, 
packing slip, bill, or Dell product catalog.

Dell provides several online and telephone-based support and service options. Availability varies by country and 
product, and some services may not be available in your area. To contact Dell for sales, technical support, or customer 
service issues, visit support.dell.com and select the support category.

If you are not a U.S. customer, select your country code at the bottom of the support.dell.com page, or select All to see 
more choices.

12



2
Preinstallation Setup
Ensure that you perform the following before installing Server Administrator:

• Read the installation instructions for the operating system.

• Read the Installation Requirements to ensure that the system meets or exceeds the minimum requirements.

• Read the applicable Dell OpenManage readme files and the Dell Systems Software Support Matrix located at 
support.dell.com/manuals.

• Close all applications running on the system before installing the Server Administrator applications.
On Linux, ensure that all operating system RPM Package Manager (RPM) packages required by the Server 
Administrator RPMs are installed. If the system had VMware ESX factory-installed, Red Hat Enterprise Linux, or 
SUSE Linux Enterprise Server, see the Dependent RPMs for Remote Enablement section for information on any 
RPMs that you need to manually install prior to installing managed system software. Typically, manual 
installation of RPMs is not required.

Prerequisite Checker
The setup.exe (located at \SYSMGMT\srvadmin\windows) starts the prerequisite checker program. The prerequisite 
checker program examines the prerequisites for software components without launching the actual installation. This 
program displays a status window that provides information about the system’s hardware and software that may affect 
the installation and operation of software features

NOTE: To use supporting agents for the Simple Network Management Protocol (SNMP), install the operating 
system support for the SNMP standard before or after you install Server Administrator. For more information about 
installing SNMP, see the installation instructions for the operating system you are running on the system.

Run the prerequisite checker silently by executing runprereqchecks.exe /s from the SYSMGMT\srvadmin
\windows\PreReqChecker directory on the Dell Systems Management Tools and Documentation DVD. After running the 
prerequisite checker, a HTML file (omprereq.htm) is created in the %Temp% directory. This file contains the results of 
the prerequisite check. The Temp directory is located at X:\Documents and Settings\username\Local Settings\Temp. To 
find %TEMP%, go to a command line prompt and type echo %TEMP%.

The results are written under the HKEY_LOCAL_MACHINE\Software\Dell Computer Corporation\OpenManage  
\PreReqChecks\MN\ key for a managed system:

While running the prerequisite checker silently, the return code from runprereqchecks.exe is the number associated 
with the highest severity condition for all the software products. The return code numbers are the same as those used in 
the registry. The following table details the return codes.

Table 2. Return Codes While Running the Prerequisite Checker Silently

Return Code Description

0 No condition, or conditions, is associated with the 
software.

1 An informational condition, or conditions, is associated 
with the software. It does not prevent a software product 
from being installed.
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Return Code Description

2 A warning condition, or conditions, is associated with the 
software. It is recommended that you resolve the 
conditions causing the warning before proceeding with 
the installation of the software. To continue, select and 
install the software using the custom installation.

3 An error condition, or conditions, is associated with the 
software. Resolve the conditions causing the error before 
proceeding with the installation of the software. If you do 
not resolve the issues, the software is not installed.

—1 A Microsoft Windows Script Host (WSH) error. The 
prerequisite checker does not run.

—2 The operating system is not supported. The prerequisite 
checker does not run.

—3 The user does not have Administrator privileges. The 
prerequisite checker does not run.

—4 Not an implemented return code.

—5 The prerequisite checker does not run. The user failed to 
change the working directory to %TEMP%.

—6 The destination directory does not exist. The prerequisite 
checker does not run.

—7 An internal error has occurred. The prerequisite checker 
does not run.

—8 The software is already running. The prerequisite checker 
does not run.

—9 The WSH is corrupted, is a wrong version, or is not 
installed. The prerequisite checker does not run.

—10 An error has occurred with the scripting environment. The 
prerequisite checker does not run.

NOTE: A negative return code (-1 through -10) indicates a failure in running the prerequisite checker tool. Probable 
causes for negative return codes include software policy restrictions, script restrictions, lack of folder 
permissions, and size constraints.

NOTE: If you encounter a return code of 2 or 3, it is recommended that you inspect the omprereq.htm file in the 
windows temporary folder %TEMP%. To find %TEMP%, run echo %TEMP% .

Common causes for a return value of 2 from the prerequisite checker:

• One of the storage controllers or drivers has outdated firmware or driver. See 
firmwaredriverversions_<lang>.html (where < lang > stands for language) or firmwaredriverversions.txt found in 
the %TEMP% folder. To find %TEMP%, run echo %TEMP%.

• RAC component software version 4 is not selected for a default install unless the device is detected on the 
system. The prerequisite checker generates a warning message in this case.

• Intel and Broadcom agents are selected for a default install only if the corresponding devices are detected on 
the system. If the corresponding devices are not found, prerequisite checker generates a warning message.

• Domain Name System (DNS) or Windows Internet Name Service (WINS) server running on the system can 
cause a warning condition for RAC software. See the relevant section in Server Administrator readme for more 
information.
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• Do not install managed system and management station RAC components on the same system. Install only the 
managed system RAC components, as they offer the required functionality.

Common causes for a return code of 3 (failure) from the prerequisite checker:

• You are not logged in with built-in Administrator privileges.

• The MSI package is corrupt or one of the required XML files is corrupt.

• Error during copying from a DVD or network access problems while copying from a network share.

• Prerequisite checker detects that another MSI package installation is currently running or that a reboot is 
pending: HKEY_LOCAL_MACHINE\\SOFTWARE\\Microsoft\Windows\CurrentVersion\Installer\InProgress 
indicates another MSI package installation is in progress. HKEY_LOCAL_MACHINE\\SYSTEM\\CurrentControlSet
\\Control\\Session Manager\\PendingFileRenameOperations indicates that a reboot is pending.

• Running the 64-bit version of Windows Server 2008 Core, since certain components are disabled from being 
installed.

Ensure that any error or warning is corrected before you proceed to install Dell OpenManage software components. 
Each software has an associated value set after running the prerequisite check. The following table provides the list of 
feature IDs for each software feature. The feature ID is a 2 to 5 character designation.

NOTE: The software feature IDs mentioned in the table are case-sensitive.

Table 3. Software Feature IDs for Managed Systems Software

Feature ID Description

ALL All features

BRCM Broadcom Network Interface Card (NIC) Agent

INTEL Intel NIC Agent

IWS Dell OpenManage Server Administrator Web Server

OMSM Server Administrator Storage Management Service

RAC4 Dell Remote Access Controller (DRAC 4)

RAC5 Dell Remote Access Controller (DRAC 5)

iDRAC (iDRAC6 for yx1x and iDRAC7 for yx2x systems) Integrated Dell Remote Access Controller

SA Server Administrator

RmtMgmt Remote Enablement

Installation Requirements
This section describes the general requirements of the Dell OpenManage Server Administrator and provides information 
on supported operating systems and web browsers.

NOTE: Prerequisites specific to an operating system are listed as part of the installation procedures.

Supported Operating Systems and Web Browsers

For information on supported operating systems and web browsers, see the Dell Systems Software Support Matrix 
located at support.dell.com/manuals.

NOTE: Ensure that the web browser is configured to bypass the proxy server for local addresses.
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Multilingual User Interface Support

The Dell OpenManage installer provides Multilingual User Interface (MUI) support available on the following operating 
systems:

• Windows Server 2008 (64-bit)

• Windows Server 2008 (64-bit) R2

• Windows Server 2008 (64-bit) R2 SP1

• Windows Small Business Server 2011 (64-bit)

The MUI Pack are a set of language-specific resource files that you can add to the English version of a supported 
Windows operating system. The Dell OpenManage 7.1 installer supports only six languages: English, German, Spanish, 
French, Simplified Chinese, and Japanese.

NOTE: When the MUI Pack is set to non-Unicode languages like Simplified Chinese, set the system locale to 
Simplified Chinese. This enables display of the prerequisite checker messages. This is because any non-Unicode 
application runs only when the system locale (also called Language for non-Unicode Programs on XP) is set to 
match the application's language.

Viewing Localized Versions of the Web-Based Interface

To view the localized versions of the web interface on Windows, in the Control Panel select Regional and Language 
Options.

System Requirements

Install Dell OpenManage Server Administrator on each system to be managed. You can manage each system running 
Server Administrator locally or remotely through a supported web browser.

Managed System Requirements

• One of the supported operating system and web browser.

• Minimum 2 GB RAM.

• Minimum 512 MB free hard drive space.

• Administrator rights.

• TCP/IP connection on the managed system and the remote system to facilitate remote system management.

• One of the Supported Systems Management Protocol Standards.

• Monitor with a minimum screen resolution of 800 x 600. The recommended screen resolution is at least 1024 x 
768.

• The Server Administrator Remote Access Controller service requires remote access controller (RAC) installed 
on the managed system. See the relevant Dell Remote Access Controller User’s Guide for complete software 
and hardware requirements.

NOTE: The RAC software is installed as part of the Typical Setup installation option, provided the managed system 
meets all of the RAC installation prerequisites.

• The Server Administrator Storage Management Service requires Dell OpenManage Server Administrator 
installed on the managed system. See the Dell OpenManage Server Administrator Storage Management User’s 
Guide for complete software and hardware requirements.

• Microsoft Software Installer (MSI) version 3.1 or later.
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NOTE: Dell OpenManage software detects the MSI version on the system. If the version is lower than 3.1, the 
prerequisite checker prompts you to upgrade to MSI version 3.1. After upgrading the MSI to version 3.1, reboot the 
system to install other software applications such as Microsoft SQL Server.

Related Links:

Supported Systems Management Protocol Standards

Supported Systems Management Protocol Standards
Install a supported systems management protocol on the managed system before installing the management station or 
managed system software. On supported Windows and Linux operating systems, Dell OpenManage software supports:

• Common Information Model (CIM)/Windows Management Instrumentation (WMI )

• Simple Network Management Protocol (SNMP)

Install the SNMP package provided with the operating system. If SNMP is installed post OMSA installation, restart 
OMSA services.

NOTE: For information about installing a supported systems management protocol standard on the managed 
system, see the operating system documentation.

The following table shows the availability of the systems management standards for each supported operating system.

Table 4. Availability of Systems Management Protocol by Operating Systems

Operating System SNMP CIM/WMI

Supported Microsoft Windows 
operating systems.

Available from the operating system 
installation media.

Always installed.

Supported Red Hat Enterprise Linux 
operating systems.

Install the SNMP package provided 
with the operating system.

Available. Install the CIM packages 
provided on the Dell Systems 
Management Tools and 
Documentation DVD - SFCB/SFCC/
CMPI-Devel.

Supported SUSE Linux Enterprise 
Server operating systems.

Install the SNMP package provided 
with the operating system.

Available. Install the CIM packages 
provided on the Dell Systems 
Management Tools and 
Documentation DVD - SFCB/SFCC/
CMPI-Devel.

NOTE: It is recommended to nstall the SFCB, SFCC, OpenWSMAN, and CMPI-Devel packages from the operating 
system media, if available.

Digital Certificates

All Server Administrator packages for Microsoft are digitally signed with a Dell certificate that helps guarantee the 
integrity of the installation packages. If these packages are repackaged, edited, or manipulated in other ways, the digital 
signature is invalidated. This manipulation results in an unsupported installation package and the prerequisite checker 
does not allow you to install the software.

Enabling Windows Installer Logging Service

Windows includes a registry-activated logging service to help diagnose Windows Installer issues.
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To enable this logging service during a silent install, open the registry editor and create the following path and keys:
HKEY_LOCAL_MACHINE\Software\Policies\Microsoft\Windows\Installer
Reg_SZ: Logging
Value: voicewarmup

The letters in the value field can be in any order. Each letter turns on a different logging mode. Each letter's actual 
function is as follows for MSI version 3.1:

v- Verbose output

o- Out-of-disk-space message

i- Status message

c- Initial UI parameter

e- All error message

w - Non-fatal warning

a- Startup of action

r- Action-specific record

m- Out-of-memory or fatal exit information

u- User request

p- Terminal property

+- Append to existing file

!- Flush each line to the log

"*"- Wildcard, log all information except for the v option. To include the v option, specify "/l*v".

Once activated, the log files are generated in the %TEMP% directory. Some log files generated in this directory are:

• Managed System Installation

– SysMgmt.log
• Management Station Installation

– MgmtSt.log

These log files are created by default if the prerequisite checker user interface (UI) is running.

Microsoft Active Directory

If you use Active Directory service software, you can configure it to control access to the network. Dell has modified the 
Active Directory database to support remote management authentication and authorization. Dell OpenManage Server 
Administrator (OMSA), IT Assistant (ITA), Integrated Dell Remote Access Controller (iDRAC), Dell Chassis Management 
Controller (CMC), and Dell Remote Access Controllers (RAC), can interface with Active Directory. Using Active Directory, 
add and control users and privileges from a central database.

Related Links:

Using Microsoft Active Directory

Configuring SNMP Agents
Dell OpenManage software supports the SNMP systems management standard on all supported operating systems. The 
SNMP support may or may not be installed depending on the operating system and how the operating system was 
installed. An installed supported systems management protocol standard, such as SNMP, is required before installing 
Dell OpenManage software.
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Configure the SNMP agent to change the community name, enable set operations, and send traps to a management 
station. To configure the SNMP agent for proper interaction with management applications such as IT Assistant, 
perform the procedures described in the Dell OpenManage Server Administrator User’s Guide at support.dell.com/
manuals.

Related Links:

• Installation Requirements

• Supported Systems Management Protocol Standards

Secure Port Server and Security Setup
This section contains the following topics:

• Setting User and Server Preferences

• x 509 Certificate Management

Setting User and Server Preferences

You can set user and secure port server preferences for Server Administrator and IT Assistant from the respective 
Preferences web page. Click General Settings and click either the User tab or Web Server tab.

Setting User Preferences

To set up user preferences:

NOTE: Log in with administrator privileges to set or reset user or server preferences.

1. Click Preferences on the global navigation bar.

2. Click General Settings.

3. To add a preselected e-mail recipient, type the e-mail address of the designated service contact in the Mail To: 
field, and click Apply Changes.

NOTE: Clicking Email in any window sends an e-mail message with an attached HTML file of the window to the 
designated e-mail address.

4. To change the home page appearance, select an alternative value in the skin or scheme fields and click Apply 
Changes.

Setting Secure Port Server Preferences

To set up secure port server preferences:

NOTE: Log in with administrator privileges to set or reset user or server preferences.

1. Click Preferences on the global navigation bar.

2. Click General Settings, and the Web Server tab.

3. Set options as necessary in the Server Preferences window:

Session Timeout Sets the time limit for a session to remain active. Select Enable to set a time-out if there is no 
user interaction for a specified time in minutes. After a session time-out, the user must log in 
again to continue. Select Disable to disable the Server Administrator session time-out feature.

HTTPS Port Specifies the secure port for Server Administrator. The default secure port for Server 
Administrator is 1311.
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NOTE: Changing the port number to an invalid or in-use port number may prevent other 
applications or browsers from accessing Server Administrator on the managed system.

IP Address to 
Bind to

Specifies the IP address(es) for the managed system that Server Administrator binds to when 
starting a session. Select All to bind to all IP addresses applicable for the system. Select 
Specific to bind to a specific IP address.

NOTE: A user with administrator privileges cannot use Server Administrator when logged 
into the system remotely.

NOTE: Changing the IP Address to Bind to value to a value other than All may prevent other 
applications or browsers from remotely accessing Server Administrator on the managed 
system.

Mail to Allows to set the default mail address for e-mail(s) from OMSA GUI.

SMTP Server 
name and DNS 
Suffix for SMTP 
Server

Specifies the organization's Simple Mail Transfer Protocol (SMTP) and Domain Name Server 
(DNS) suffix. To enable Server Administrator to send e-mails, you must type the IP address and 
DNS suffix for the SMTP server for the organization in the appropriate fields.

NOTE: For security reasons, the organization may not allow e-mails to be sent through the 
SMTP server to outside accounts.

Command Log 
Size

Specifies the largest file size in MB for the command log file.

Support Link Specifies the web address for the business entity that provides support for the managed 
system.

Custom Delimiter Specifies the character used to separate the data fields in the files created using the Export 
button. The ; character is the default delimiter. Other options are !, @, #, $, %, ^, *, ~, ?, :,|, and ,.

4. Click Apply Changes.

X.509 Certificate Management

Web certificates are necessary to ensure that the identity and information exchanged with a remote system is not 
viewed or changed by others. To ensure system security, it is strongly recommended that you either generate a new X.
509 certificate, reuse an existing X.509 certificate, or import a root certificate or certificate chain from a Certificate 
Authority (CA). Authorized CAs include Verisign, Entrust, and Thawte.

NOTE: Log in with administrator privileges to perform certificate management.

You can manage X.509 certificates for Server Administrator and IT Assistant from the respective Preferences page. Click 
General Settings, select the Web Server tab, and click X.509 Certificate.

Best Practices for X.509 Certificate Management
For the security of the system while using server administrator, ensure the following:

Unique host name All systems that have Server Administrator installed should have unique host names.

Change 'localhost' to unique For systems with host name set to localhost change the host name to a unique host 
name.
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Remote Enablement Requirements
The Remote Enablement feature is currently supported on:

• Microsoft Windows
• Microsoft Hyper-V
• Hyper-V Server
• Red Hat Enterprise Linux
• SUSE Enterprise Linux
• VMware ESXi and ESX
• Citrix XenServer 6.0

To install the Remote Enablement feature, configure the following on the system:

• Windows Remote Management (WinRM)
• CA/Self-Signed Certificate
• WinRM HTTPS Listener Port
• Authorization for WinRM and Windows Management Instrumentation (WMI) Servers

Installing WinRM

On Windows Server 2008 R2, Windows Server 2008 R2 SP1 and Windows 7, WinRM 2.0 is installed by default. On 
Windows Server 2008, WinRM 1.1 is installed by default.

Certificate Authority Signed Self-Signed Certificate

You need a certificate signed by a CA or a self‑signed certificate (generated using the SelfSSL tool) to install and 
configure the Remote Enablement feature on the system.

NOTE: It is recommended that you use a certificate signed by a CA.

Using a Certificate Signed by a CA

To use a certificate signed by a CA:

1. Request a valid CA signed certificate.
2. Create a HTTP listener with the CA signed certificate.

Requesting a Valid CA Signed Certificate 

To request a valid CA signed certificate:

1. Click Start → Run.
2. Type mmc and click OK.
3. Click File → Add/Remove Snap-in.
4. Select Certificates and click Add.
5. In the Certificates snap-in dialog box, select Computer account, click Next.
6. Select Local Computer and click Finish.
7. Click Close and click OK.
8. On the Console window, expand Certificates (Local Computer) in the left navigation pane.
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9. Right-click Personal, select All tasks → Request New Certificate .

10. Click Next.

11. Select the appropriate certificate type, Mostly (Computer), and click Enroll.

12. Click Finish.

Creating the HTTPS Listener With the Valid CA Signed Certificate
Run the installer and click the link on the prerequisite checker to create the HTTPS listener.

Using the SelfSSL Tool to Generate Self-Signed Certificates

To generate a self-signed certificate using the SelfSSL tool :

1. Create a certificate.

2. Add the certificate and take a thumbprint.

3. Create the WinRM HTTPS listener.

4. Configure the Envelope size for WinRM.

Creating a Certificate

1. Download the IIS Resource Kit from microsoft.com/downloads/details.aspx?FamilyID=56fc92ee-a71a-4c73-b628-
ade629c89499&displaylang.

2. Run iis60rkt.exe.

3. Click Next.

4. Select I Agree in the End-User License Agreement screen and click Next.

5. Click Next.

6. In the Select Type screen, select Custom and click Next.

7. Click Next.

8. In the Select Features screen, select SelfSSL 1.0 and click Next.

9. Click Next.

10. Click Finish.
The SelfSSL is installed.

11. Click Start → Programs → IIS Resource → SelfSSL → SelfSSL.

12. Type selfssl /T /N:CN=<computer_name or domain_name>.

Adding a Certificate and Taking a Thumbprint

To add a certificate and take a thumbprint:

NOTE: If Internet Information Service (IIS) is already installed on the system, then the value of 
CertificateThumbprint is an empty string and you need not perform the steps in this section. For example:
winrm create winrm/config/Listener?Address=*+Transport=HTTPS 
@{Hostname="<host_name>";CertificateThumbprint=""}

1. Click Start → Run.

2. Type mmc and click OK.

3. Click File → Add/Remove Snap-in.

4. Click Add.

5. Click Certificates and click Add.

6. In the Certificates snap-in dialog box, select Computer account option and click Next.

7. Select Local Computer and click Finish.
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8. Click Close.

9. Click OK.

10. On the Console window, expand Certificates (Local Computer) in the left navigation pane.

11. Expand Personal.

12. Select Certificates.

13. In the right-hand pane, double-click the required certificate.
The Certificate screen is displayed.

14. Click Details tab.

15. Select Thumbprint.

16. Copy the thumbprint to the clipboard.
You can use this parameter while creating the HTTPS listener.

17. Click OK.

Creating the WinRM HTTPS Listener
To enable the HTTPS listener on WinRM, type the following command:
winrm create winrm/config/Listener?Address=*+Transport=HTTPS
@{Hostname="<host_name>";CertificateThumbprint="6e132c546767bf16a8acf4fe0e713d5b
2da43013"}

If you are using Windows Server 2008 Small Business Server, leave the value of CertificateThumbprint blank 
as follows:
winrm create winrm/config/Listener?Address=*+Transport=HTTPS
@{Hostname="<host_name>";CertificateThumbprint=""}

NOTE: Ensure that the values of the Hostname and CertificateThumbprint are correct.

The HTTP listener is enabled by default and listens at port 80.

Configuring User Authorization for WinRM and WMI Servers
To provide access rights to WinRM and WMI services, explicitly add users with the appropriate access levels.

NOTE: To configure user authorization - For WinRM and WMI Servers, you must login with administrator privileges. 
- For Windows Server 2008 operating systems, you must login with built-in administrator privileges

NOTE: The administrator is configured by default.

WinRM
To configure user authorization for WinRM servers:

1. Click Start → Run.

2. Type winrm configsddl and click OK.

If you are using WinRM 2.0, type winrm configsddl default.

3. Click Add and add the required users or groups (local/domain) to the list.

4. Provide the appropriate permission(s) to the respective users and click OK.

WMI
To configure user authorization for WMI servers:

1. Click Start → Run.

2. Type wmimgmt.msc and click OK.

The Windows Management Infrastructure (WMI) screen is displayed.

3. Right-click the WMI Control (Local) node in the left pane and click Properties.
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The WMI Control (Local) Properties screen is displayed.

4. Click Security and expand the Root node in the namespace tree.
5. Navigate to Root → DCIM → sysman.
6. Click Security.

The Security screen is displayed.

7. Click Add to add the required users or groups (local/domain) to the list.
8. Provide the appropriate permission(s) to the respective users and click OK.
9. Click OK.
10. Close the Windows Management Infrastructure (WMI) screen.

Configuring the Windows Firewall for WinRM 

To configure the Windows Firewall for WinRM:

1. Open Control Panel.
2. Click Windows Firewall.
3. Click Exceptions tab.
4. Select Windows Remote Management check box. If you do not see the check box, click Add Program to add 

Windows Remote Management.

Configuring the Envelope Size for WinRM

To configure the envelope size for WinRM:

NOTE: On WinRM version 2.0, enable the compatibility mode for WinRM version 2.0 to use port 443. WinRM version 
2.0 uses port 5986 by default. To enable the compatibility mode, type the following command:
winrm s winrm/config/Service @{EnableCompatibilityHttpsListener="true"}

1. Open a command prompt.
2. Type winrm g winrm/config.

3. Check the value of the MaxEnvelopeSizekb attribute. If the value is less than 4608, type the following command:
winrm s winrm/config @{MaxEnvelopeSizekb="4608"}

4. Set the value of MaxTimeoutms to 3 minutes:
winrm s winrm/config @{MaxTimeoutms ="180000"}

Dependent RPMs for Remote Enablement

If you choose to install the Remote Enablement feature, you have to install certain dependent RPMs and configure these 
RPMs before installing the feature. Install the following RPMs:

• libcmpiCppImpl0

• libwsman1

• openwsman-server

• sblim-sfcb

• sblim-sfcc

The dependent RPMs are available on the Dell Systems Management Tools and Documentation DVD at srvadmin\linux
\RPMS\supportRPMS\opensource-components\<OS>\<arch>.

NOTE: On supported SLES 11 and above and Red Hat Enterprise Linux 6 and preceding operating systems, it is 
recommended that you install the RPMs from the operating system media, if available.
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Installing Dependent RPMs

To install the dependent RPMs not available on the operating system media:

1. Make sure that Pegasus RPMs are uninstalled.
2. Check if the openwsmand and sfcbd binaries are already installed using make-install. Check by running the 

commands: openwsman or sfcbd or you can check the existence of the binaries in the /usr/local/sbin directory.
3. If the binaries are installed, uninstall these binaries.
4. Check for the required dependencies for the openwsman and sfcbd RPMs listed in the following table.

Table 5. Required Dependencies

Packages Red Hat Enterprise Server SUSE Linux Enterprise Server

Openwsman OpenSSL
LibXML
Pkgconfig
CURL
Chkconfig
Initscript
SBLIM-SFCC

LibOpenSSL
LibXML
Pkg-config
libCURL
aaa_base
aaa_base
SBLIM-SFCC

SBLIM SFCC CURL LibCURL

SBLIM SFCB zlib
CURL
PAM
OpenSSL
Chkconfig
Initscript

zlib
LibCURL
PAM
LibOpenSSL
aaa_base
aaa_base

5. Install the dependent RPMs. You can install the RPMs:

– with a single command rpm -ivh rpm1 rpm2 rpm3 rpm4 … rpmN
or

– individually

NOTE: If you are installing RPMs individually, follow this sequence.

rpm -ivh sblim-sfcb-x.x.x.rpm 
rpm -ivh sblim-sfcc-x.x.x.rpm

NOTE: Install the libwsman and openwsman client RPMs simultaneously as they have cyclic dependency.

rpm -ivh libwsman1-x.x.x.rpm openwsman-client-x.x.x.rpm
rpm -ivh openwsman-server-x.x.x.rpm

Post-Installation Configuration for Remote Enablement

This section details the steps to configure the dependent RPMs if you have installed the Remote Enablement feature.

The post-installation configuration script is available at /opt/dell/srvadmin/etc/ on the server file system.

After installing all the dependent RPMs and the Remote Enablement feature, execute the autoconf_cim_component.sh 
script.

Before executing the autoconf_cim_component.sh script, make sure that Dell OpenManage is installed.
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Execute the following command to configure sfbc and openwsman as per the default configurations: ./ 
autoconf_cim_component.sh

NOTE: To configure openwsman on the managed node to run on a different port, use the -p <port> option with 
autoconf_cim_component.sh. This is optional and by default the openwsman is configured to run on port 443.

Related Links:

Installing Managed System Software on Supported Linux and VMware ESX

Creating Server Certificate for WSMAN
You can either create a new certificate for WSMAN or reuse an existing certificate.

Creating a New Certificate
You can create a new server certificate for WSMAN by executing the owsmangencert.sh script located at /etc/
openwsman. This script is provided by the openwsman RPM. Follow the steps in the wizard to create the server 
certificate.

Reusing an Existing Certificate
If you have a self-signed or CA-signed certificate, you can use the same certificate for the openwsman server by 
updating the ssl_cert_file and ssl_key_file values, grouped under [server] tag, in /etc/openwsman/
openwsman.conf with the existing certificate values.

Configuring CRL for the openwsman Client

You need to configure the Certificate Revocation List (CRL) used by Server Administrator Web Server. To do this:

1. Mention a valid CRL file in /etc/openwsman/openwsman_client.conf.

2. If left blank, the CRL check is ignored.

NOTE: CRL support is only present on SUSE Linux Enterprise Server version 11 and Red Hat Enterprise Linux Server 
version 5 update 5. For other operating systems, contact the operating system vendor to provide the required CURL 
library with CRL support.

Running sfcb and openwsman
Run sfcb and openwsman:

• /etc/init.d/sfcb start
• /etc/init.d/openwsmand start

NOTE: On Red Hat Enterprise Linux 6, replace sfcb with sblim-sfcb.

On Red Hat Enterprise Linux 6, for the sblim-sfcb and openwsman to start automatically after a reboot you need to 
change the run-levels using the chkconfig utility. For example, if you want to run sblim-sfcb in run-levels 3 and 5, 
use the following command:
#chkconfig sblim-sfcb on --level 35

NOTE: For more information on chkconfig and its usage, see the operating system documentation.

The managed system is configured and is ready to be used by the Server Administrator Web Server.

Winbind Configuration for openwsman and sfcb for Red Hat 
Enterprise Linux Operating Systems
Follow the instructions mentioned below to configure openwsman and sfcb on 32-bit OMI installation. In case of a 64-bit 
installation, replace with .lib lib64
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1. Back up these files:

– /etc/pam.d/openwsman
– /etc/pam.d/sfcb
– /etc/pam.d/system-auth

2. Replace the content of /etc/pam.d/openwsman and /etc/pam.d/sfcb with
auth required pam_stack.so service=system-auth
auth required /lib/security/pam_nologin.so
account required pam_stack.so service=system-auth

3. Replace the content of /etc/pam.d/system-auth with
%PAM-1.0
This file is auto-generated.
User changes will be destroyed the next time authconfig is run.
auth required /lib/security/$ISA/pam_env.so
auth sufficient /lib/security/$ISA/pam_unix.so likeauth nullok
auth sufficient /lib/security/$ISA/pam_krb5.so use_first_pass
auth sufficient /lib/security/$ISA/pam_winbind.so use_first_pass
auth required /lib/security/$ISA/pam_deny.so
account required /lib/security/$ISA/pam_unix.so broken_shadow
account sufficient /lib/security/$ISA/pam_succeed_if.so uid 100 quiet
account [default=bad success=ok user_unknown= ignore] /lib/security/$ISA/
pam_krb5.so
account [default=bad success=ok user_unknown= ignore] /lib/security/$ISA/
pam_winbind.so
account required /lib/security/$ISA/pam_permit.so
password requisite /lib/security/$ISA/pam_cracklib.so retry=3
password sufficient /lib/security/$ISA/pam_unix.so nullok use_authtok md5 
shadow
password sufficient /lib/security/$ISA/pam_krb5.so use_authtok
password sufficient /lib/security/$ISA/pam_winbind.so use_authtok
password required /lib/security/$ISA/pam_deny.so
session required /lib/security/$ISA/pam_limits.so
session required /lib/security/$ISA/pam_unix.so
session optional /lib/security/$ISA/pam_krb5.so

Winbind Configuration for openwsman and sfcb for SUSE Linux 
Enterprise Server Operating System
Follow the instructions mentioned below to configure openwsman and sfcb on 32-bit OMI installation. In case of a 64-bit 
installation, replace .lib with .lib64.

1. Back up the following files:

– /etc/pam.d/openwsman
– /etc/pam.d/sfcb
– /etc/pam.d/system-auth
– /etc/pam.d/common-account

2. Replace the content of /etc/pam.d/openwsman/ and /etc/pam.d/sfcb with
%PAM-1.0
auth include common-auth
auth required /lib/security/pam_nologin.so
account include common-account

3. Replace the content of /etc/pam.d/common-auth with
auth required pam_env.so
auth sufficient pam_unix2.so debug
auth sufficient pam_winbind.so use_first_pass debug

27



4. Replace the content of /etc/pam.d/common-account with
account sufficient pam_unix2.so
account sufficient pam_winbind.so

Workaround for the Libssl Issue
If the required library needed by openwsman is present on the system, the autoconf_cim_component.sh script tries to 
resolve the libssl.so issue. However, if the library is not present, then the script reports the same. Check if the latest 
version of the libssl library is installed on the system and then create a soft link with libssl.so.

For example: On a 32-bit Dell OpenManage installation, if you have libssl.so.0.9.8a and libssl.so.0.9.8b 
in /usr/lib, then create soft link with the latest libssl.so.0.9.8b:

• ln -sf /usr/lib/libssl.so.0.9.8b /usr/lib/libssl.so
• ldconfig

On a 64-bit Dell OpenManage installation, if you have libssl.so.0.9.8a and libssl.so.0.9.8b in /usr/lib, 
then create soft link with the latest libssl.so.0.9.8b:

• ln -sf /usr/lib64/libssl.so.0.9.8b /usr/lib64/libssl.so
• ldconfig
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3
Installing Managed System Software on 
Microsoft Windows Operating Systems 
On Microsoft Windows, an autorun utility is displayed when you insert the Dell Systems Management Tools and 
Documentation DVD. This utility allows you to choose the systems management software you want to install on the 
system.

If the autorun program does not start automatically, use the setup program in the SYSMGMT\srvadmin\windows 
directory on the Dell Systems Management Tools and Documentation DVD. See the Dell Systems Software Support 
Matrix for a list of operating systems currently supported.

NOTE: Use the Dell Systems Management Tools and Documentation DVD to perform an unattended and scripted 
silent installation of the managed system software. Install and uninstall the features from the command line.

Deployment Scenarios for Server Administrator
You can install Dell OpenManage Server Administrator in the following ways:

• Install the Server Administrator Web Server on any system (Dell PowerEdge system, laptop, or desktop) and the 
Server Instrumentation on another supported Dell PowerEdge system.
In this method, the Server Administrator Web Server performs the function of a central web server and you can 
use it to monitor a number of managed systems. Using this method reduces the Server Administrator footprint on 
the managed systems.

• Continue to install the Server Administrator Web Server and the Server Instrumentation on the same system.

The following table lists the deployment scenarios for installing and using Server Administrator and helps you make the 
right choice while selecting the various installation options:

Table 6. Deployment Scenarios

You want to Select

Remotely manage and monitor the entire network of 
managed systems from the system (laptop, desktop, or 
server).

Server Administrator Web Server. You must then install 
Server Instrumentation on the managed systems.

Manage and monitor the current system. Server Administrator Web Server and Server 
Instrumentation.

Manage and monitor the current system using some other 
remote system.

Remote Enablement
For systems running on Microsoft Windows, Remote 
Enablement is under the Server Instrumentation option. 
You must then install the Server Administrator Web Server 
on the remote system.

View the status of local and remote storage attached to a 
managed system and obtain storage management 
information in an integrated graphical view.

Storage Management.
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You want to Select

Remotely access an inoperable system, receive alert 
notifications when a system is down, and remotely restart 
a system.

Remote Access Controller.

NOTE: Install the Simple Network Management Protocol (SNMP) agent on the managed system using the 
operating system medium before installing the managed system software.

Installing Server Administrator 

This section explains how to install the Server Administrator and other managed system software using two 
installation options:

• Using the setup program at \SYSMGMT\srvadmin\windows on the Dell Systems Management Tools and 
Documentation DVD.

• Using the unattended installation method through the Windows Installer Engine msiexec.exe.

NOTE: SNMP service is stopped and started during Systems Management installation and uninstallation. As a 
result, services like DSM IT Assistant Connection Service, DSM IT Assistant Network Monitor and other third party 
services, dependent on SNMP stop. IT Assistant services is started at the end of Systems Management installation 
or uninstallation. If the third party services are stopped, manually restart these services.

NOTE: For Blade systems, you must install Server Administrator on each server module installed in the chassis.

NOTE: During installation of Server Administrator on supported Windows systems, if an Out of Memory error 
message is displayed, you must exit the installation and free up memory. Close other applications or perform any 
other task that frees up memory, before re-attempting Server Administrator installation.

The setup program invokes the prerequisite checker, which uses the system's Peripheral Component Interconnect (PCI) 
bus to search for installed hardware such as controller cards.

The Dell OpenManage installer features a Typical Setup option and a Custom Setup option for installing Server 
Administrator and other managed system software.

Related Links:

• Deployment Scenarios for Server Administrator

• Optional Command Line Settings

Typical Installation
When you launch the Server Administrator installation from the prerequisite checker and select the Typical Setup 
option, the setup program installs the following managed system software features:

• Server Administrator Web Server

• Server Instrumentation

• Remote Access Controller

• Intel SNMP Agent

• Broadcom SNMP Agent

During a Typical installation, individual management station services that do not meet the specific hardware and 
software requirement for that service are not installed on the managed systems. For example, the Dell OpenManage 
Server Administrator Remote Access Controller service software module is not installed during a Typical installation 
unless the managed system has a remote access controller installed on it. You can, however, go to Custom Setup and 
select the Remote Access Controller software module for installation.
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NOTE: The Remote Enablement feature is available only through the Custom Setup option.

NOTE: Server Administrator installation also installs some of the required Visual C++ runtime components on 
the system.

Custom Installation

The sections that follow describe how to install Server Administrator and other managed system software using the 
Custom Setup option.

NOTE: Management station and managed system services can be installed in the same or in different directories. 
You can select the directory for installation.

1. Log in with built-in administrator privileges to the system on which you want to install the system management 
software.

2. Close all open applications and disable any virus-scanning software.

3. Insert the Dell Systems Management Tools and Documentation DVD into the system's DVD drive. The autorun menu 
is displayed.

4. Select Dell OpenManage Server Administrator from the autorun menu and click Install.
The Dell OpenManage Server Administrator prerequisite status screen is displayed and runs the prerequisite 
checks for the managed system. Any relevant informational, warning, or error messages are displayed. Resolve all 
error and warning situations, if any.

5. Click the Install, Modify, Repair, or Remove Server Administrator option.
The Welcome to the Install Wizard for Dell OpenManage Server Administrator screen is displayed.

6. Click Next.
The Dell Software License Agreement is displayed.

7. Click I accept the terms in the license agreement and Next if you is displayed.
The Setup Type dialog box is displayed.

8. Select Custom and click Next.
If you are installing Server Administrator on a non-Dell PowerEdge system, the installer displays only the Server 
Administrator Web Server option.

A selected feature has a hard drive icon depicted next to it. A deselected feature has a red X depicted next to it. By 
default, if the prerequisite checker finds a software feature with no supporting hardware, the checker deselects 
them.

To accept the default directory path to install managed system software, click Next. Otherwise, click Change and 
navigate to the directory where you want to install the managed system software, and click OK.

The Custom Setup dialog box is displayed.

9. Click Next on the Custom Setup dialog box to accept the selected software features for installation.
The Ready to Install the Program dialog box is displayed.

NOTE: You can cancel the installation process by clicking Cancel. The installation rolls back the changes that you 
made. If you click Cancel after a certain point in the installation process, the installation may not roll back properly, 
leaving the system with an incomplete installation.

10. Click Install to install the selected software features.
The Installing Dell OpenManage Server Administrator screen is displayed and provides the status and progress of 
the software features being installed. After the selected features are installed, the Install Wizard Completed dialog 
box is displayed.

11. Click Finish to exit the Server Administrator installation.
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If you are prompted to reboot the system, select from the following reboot options to make the installed managed 
system software services available for use:

– Yes, reboot my system now.
– No, I will reboot my system later.

NOTE: If you have selected Remote Enablement during installation, an error message A provider, 
WinTunnel, has been registered in the Windows Management Instrumentation 
namespace ROOT\dcim\sysman to use the LocalSystem account. This account is 
privileged and the provider may cause a security violation if it does not 
correctly impersonate user requests. is logged in Windows Event Log. You can safely ignore this 
message and continue with installation.

Related Links:

System Recovery on Failed Installation

Server Administrator Installation With Citrix Application Server

Citrix remaps all the hard drive letters when installed. For example, if you install Server Administrator on drive C: and 
then install Citrix, it may change the drive letter C: to M:. Server Administrator may not work properly because of the 
remapping.

In order to avoid this problem, select one of the following options:

Option 1:

1. Uninstall Server Administrator.
2. Install Citrix.
3. Reinstall Server Administrator.

Option 2:

After installing Citrix, type the command msiexec.exe /fa SysMgmt.msi

Performing an Unattended Installation of Managed System Software 
The Dell OpenManage installer features a Typical Setup option and a Custom Setup option for the unattended 
installation procedure.

Unattended installation enables you to simultaneously install Server Administrator on multiple systems. Perform an 
unattended installation by creating a package that contains the necessary managed system software files. The 
unattended installation option also provides several features that enable you to configure, verify, and view information 
about unattended installations.

The unattended installation package is distributed to the remote systems using a software distribution tool from an 
independent software vendor (ISV). When the package is distributed, the installation script executes to install the 
software.

Creating and Distributing the Typical Unattended Installation Package
The Typical Setup unattended installation option uses the Dell Systems Management Tools and Documentation DVD as 
the unattended installation package. The msiexec.exe /i SysMgmt.msi /qb command accesses the DVD to 
accept the software license agreement and installs all the required Server Administrator features on selected remote 
systems. These features are installed on the remote systems based on the system's hardware configuration.

NOTE: After an unattended installation is complete, to use the command line interface (CLI) feature of Server 
Administrator, you must open a new console window and execute the CLI commands from there. Executing 
CLI commands from the same console window in which Server Administrator was installed does not work.

You can make the DVD image available to the remote system by either distributing the entire contents of the media, or by 
mapping a drive from the target system to the location of the DVD image.
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Mapping a Drive to Act as the Typical Unattended Installation Package

1. Share an image of the Dell Systems Management Tools and Documentation DVD with each remote system on 
which you want to install Server Administrator.
You can accomplish this task by directly sharing the DVD or by copying the entire DVD to a drive and sharing the 
copy.

2. Create a script that maps a drive from the remote systems to the shared drive described in step 1. This script should 
execute msiexec.exe /i Mapped Drive\SYSMGMT\srvadmin\windows\ SystemsManagement
\SysMgmt.msi /qb after the drive has been mapped.

3. Configure the ISV distribution software to distribute and execute the script created in step 2.

4. Distribute this script to the target systems by using the ISV software distribution tools.
The script executes to install Server Administrator on each remote system.

5. Reboot each remote system to enable Server Administrator.

Distributing the Entire DVD as the Typical Unattended Installation Package

1. Distribute the entire image of the Dell Systems Management Tools and Documentation DVD to the target systems.

2. Configure the ISV distribution software to execute the msiexec.exe /i DVD Drive\SYSMGMT
\srvadmin\windows\SystemsManagement\SysMgmt.msi /qb command from the DVD image.

The program executes to install Server Administrator on each remote system.

3. Reboot each remote system to enable Server Administrator.

Creating Custom Unattended Installation Packages

To create a custom unattended installation package, perform the following steps:

1. Copy the SYSMGMT\srvadmin\windows directory from the DVD to the system hard drive.

2. Create a batch script that executes the installation using the Windows Installer Engine (msiexec.exe).

NOTE: For Customized Unattended Installation, each required feature must be included as a command line 
interface (CLI) parameter for it to be installed.

An example is msiexec.exe /i SysMgmt.msi ADDLOCAL= SA,IWS,BRCM /qb.

3. Place the batch script in the windows directory on the system hard drive.

Related Links:

Customization Parameters

Distributing Custom Unattended Installation Packages

For distributing custom unattended installation packages:

NOTE: The SysMgmt.msi installation package for Server Administrator used in the Custom Setup unattended 
installation is located in the SYSMGMT\srvadmin\ windows\SystemsManagement directory in the DVD.

1. Configure the ISV distribution software to execute the batch script once the installation package is distributed.

2. Use the ISV distribution software to distribute the custom unattended installation package to the remote systems. 
The batch script installs Server Administrator along with specified features on each remote system.
The batch script installs Server Administrator along with specified features on each remote system.

3. Reboot each remote system to enable Server Administrator.

Related Links:

• Creating Custom Unattended Installation Packages
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• Distributing Custom Unattended Installation Packages

Specifying Log File Locations
For managed system MSI installation, run the following command to perform an unattended installation while specifying 
the log file location
msiexec.exe /i SysMgmt.msi /l*v 
"C:\openmanage\logs\SysMgmt.log" 

Unattended Installation Features
Unattended installation provides the following features:

• A set of optional command line settings to customize an unattended installation.

• Customization parameters to designate specific software features for installation.

• A prerequisite checker program that examines the dependency status of selected software features without 
having to perform an actual installation.

Optional Command Line Settings
The following table shows the optional settings available for the msiexec.exe MSI installer. Type the optional settings on 
the command line after msiexec.exe with a space between each setting.

NOTE: See support.microsoft.com for details about all the command line switches for the Windows Installer Tools.

Table 7. Command Line Settings for MSI Installer

Setting Result

/i <Package|Product Code> This command installs or configures a product.
/i SysMgmt.msi – Installs the Server Administrator 
software.

/i SysMgmt.msi /qn This command carries out a fresh installation of version 
7.1.

/x <Package|Product Code> This command uninstalls a product.
/x SysMgmt.msi – Uninstalls the Server Administrator 
software.

/q[n|b|r|f] This command sets the user interface (UI) level.
/q or /qn – no UI. This option is used for silent and 
unattended installation.
/qb – basic UI. This option is used for unattended but not 
silent installation.
/qr – reduced UI. This option is used for unattended 
installation while displaying a modal dialog box showing 
install progress.
/qf – full UI. This option is used for standard attended 
installation.

/f[p|o|e|d|c|a|u |m|s|v]<Package| 
ProductCode>

This command repairs a product.
/fp – This option reinstalls a product if a file is missing.
/fo – This option reinstalls a product if a file is missing or if 
an older version of a file is installed.
/fe – This option reinstalls a product if a file is missing or 
an equal or older version of a file is installed.
/fd – This option reinstalls a product if a file is missing or a 
different version of a file is installed.
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Setting Result

/fc – This option reinstalls a product if a file is missing or 
the stored checksum value does not match the calculated 
value.
/fa – This option forces all files to be reinstalled.
/fu – This option rewrites all required user-specific 
registry entries.
/fm – This option rewrites all required system-specific 
registry entries.
/fs – This option overwrites all existing shortcuts.
/fv – This option runs from the source and re-caches the 
local package. Do not use this reinstall option for the first 
installation of an application or feature.

INSTALLDIR=<path> This command installs a product in a specific location. If 
you specify an install directory with this switch, it must be 
created manually prior to executing the CLI install 
commands or they fail without displaying an error 
message.
/i SysMgmt.msi INSTALLDIR=c:\OpenManage /qn – 
installs a product to a specific location where c:
\OpenManage is the install location.

For example, running msiexec.exe /i SysMgmt.msi /qn installs Server Administrator features on each 
remote system based on the system's hardware configuration. This installation is done silently and unattended.

Customization Parameters
REINSTALL and REMOVE customization CLI parameters provide a way to customize the exact software features to 
install, reinstall, or uninstall when running a silent or unattended installation. With the customization parameters, you 
selectively install, reinstall, or uninstall software features for different systems using the same unattended installation 
package. For example, you can choose to install Server Administrator, but not Remote Access Controller service on a 
specific group of servers, and choose to install Server Administrator, but not Storage Management Service, on another 
group of servers. You can also choose to uninstall one or multiple features on a specific group of servers.

NOTE: Type the REINSTALL, and REMOVE CLI parameters in upper case, as they are case‑sensitive.

You can include the REINSTALL customization parameter on the command line and assign the feature ID (IDs) of the 
software feature that you want to reinstall. For example, msiexec.exe /i SysMgmt.msi 
REINSTALL=BRCM /qb
This command runs the installation for Dell OpenManage Systems Management and reinstalls only the Broadcom agent, 
in an unattended but not silent mode.

You can include the REMOVE customization parameter on the command line and assign the feature ID (IDs) of the 
software feature that you want to uninstall. For example, msiexec.exe /i SysMgmt.msi REMOVE=BRCM /qb
This command runs the installation for Dell OpenManage Systems Management and uninstalls only the Broadcom 
agent, in an unattended but not silent mode.

You can also choose to install, reinstall, and uninstall features with one execution of the msiexec.exe program. For 
example, msiexec.exe /i SysMgmt.msi REMOVE=BRCM /qb
This command runs the installation for managed system software, and uninstalls the Broadcom agent. This execution is 
in an unattended but not silent mode.

Related Links:

Software Feature IDs
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MSI Return Code
An application event log entry is recorded in the SysMgmt.log file. The following table shows some of the error codes 
returned by the msiexec.exe Windows Installer Engine.
Table 8. Windows Installer Return Codes

Error Code Value Description

ERROR_SUCCESS 0 The action is completed successfully.

ERROR_INVALID_PARAMETER 87 One of the parameters was invalid.

ERROR_INSTALL_USEREXIT 1602 The user canceled the installation.

ERROR_SUCCESS_REBOOT_REQUI
RED

3010 A restart is required to complete the installation. This 
message is indicative of a successful installation.

NOTE: For more information on all the error codes returned by the msiexec.exe and InstMsi.exe Windows Installer 
functions, see support.microsoft.com.

Managed System Software Installation Using Third Party Deployment Software
Use third-party deployment software, such as Altiris Deployment Solution, to install managed systems software on 
supported Dell systems. To distribute and install Server Administrator using Altiris, start the Altiris application and import 
OpenManage_Jobs.bin located at SYSMGMT\srvadmin\support\Altiris on the Dell Systems Management Tools and 
Documentation DVD. Specify a job folder to import OpenManage_Jobs.bin. Modify the Run Script and Copy File tasks to 
match the deployment environment. When complete, schedule the job to run on the supported Dell systems that are 
managed from the Altiris Deployment Solution.

System Recovery on Failed Installation
The Microsoft Software Installer (MSI) provides the ability to return a system to its fully working condition after a failed 
installation. MSI does this by maintaining an undo operation for every standard action it performs during an install, 
upgrade, or uninstall. This operation includes restoration of deleted or overwritten files, registry keys, and other 
resources. Windows temporarily saves all files that it deletes or overwrites during the course of an installation or 
removal, so that they can be restored if necessary, which is a type of rollback. After a successful installation, Windows 
deletes all of the temporary backup files.

In addition to the rollback of MSI Standard Actions, the Dell OpenManage library also has the ability to undo commands 
listed in the INI file for each application if a rollback occurs. All files that are modified by the Dell OpenManage 
installation actions are restored to their original state if a rollback occurs.

When the MSI engine is going through the installation sequence, it ignores all actions that are scheduled as rollback 
actions. If a Custom Action, MSI Standard Action, or a Dell OpenManage installation action fails, then a rollback starts.

You cannot roll back an installation once it is completed; transacted installation is only intended as a safety net that 
protects the system during an installation session. If you want to remove an installed application, you should uninstall 
that application.

NOTE: Driver installation and removal is not executed as part of the installation transaction and therefore cannot 
be rolled back if a fatal error occurs during execution.

NOTE: Installations, uninstallations, and upgrades that you cancel during installer cleanup, or after the installation 
transaction is completed, are not rolled back.

Failed Updates

Apply the MSI patches and updates provided by vendors to the original vendor MSI packages provided. If you 
intentionally or accidentally repackage an MSI package, or make changes to it directly, patches and updates may fail. 
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MSI packages must not be repackaged; doing so changes the feature structure and Globally Unique Identifier (GUID), 
which break any provided patches or updates. When it is necessary to make any changes to a vendor-provided MSI 
package, use a .mst transform file.

NOTE: A GUID is 128-bit long, and the algorithm used to generate a GUID guarantees unique GUID. The product 
GUID uniquely identifies the application.

Upgrading Managed System Software
The Dell OpenManage installer provides an Upgrade option for upgrading Server Administrator and other managed 
system software.

The setup program runs the prerequisite checker, which uses the system's PCI bus to search for installed hardware, 
such as controller cards.

The setup program installs or upgrades all of the managed system software features that are appropriate for the 
particular system's hardware configuration.

NOTE: All user settings are preserved during upgrades.

The following procedures show how to upgrade Server Administrator and other managed system software.

Upgrading Guidelines

• You can upgrade to the latest version of Dell OpenManage Server Administrator from any of the previous three 
versions. For example, upgrade to Dell OpenManage Server Administrator 7.1 is supported only for Dell 
OpenManage Server Administrator versions 6.4 and later.

• To upgrade from versions earlier than 6.3, uninstall the existing Server Administrator and reinstall the latest 
Server Administrator.

NOTE: Uninstalling Server Administrator deletes its user settings. Reinstall Server Administrator and apply the user 
settings.

• When upgrading an operating system to a major version, uninstall the existing OpenManage software and 
reinstall the latest OpenManage software. When upgrading only to an update level change (for example, Red 
Hat Enterprise Linux 5 Update 7 to Red Hat Enterprise Linux 5 Update 8), upgrade to the latest OpenManage 
software; all user settings are preserved.

NOTE: Uninstalling OpenManage software deletes its user settings. Reinstall OpenManage software and apply the 
user settings.

• If you have installed Server Administrator Web Server version 7.1, ensure that you install Server Instrumentation 
version 7.1 on the managed system. Accessing an earlier version of Server Administrator using Server 
Administrator Web Server version 7.1 may display an error.

Upgrade

For an unattended upgrade, the msiexec.exe /i SysMgmt.msi /qb command accesses the DVD to accept the 
software license agreement and upgrades all the required Server Administrator features on selected remote systems. 
All major user settings are retained during an unattended upgrade.

1. Insert the Dell Systems Management Tools and Documentation DVD into the system's DVD drive. The autorun menu 
is displayed.

2. Select Dell OpenManage Server Administrator and click Install.
If the autorun program does not start automatically, go to the SYSMGMT\srvadmin\windows directory on the DVD, 
and run the setup.exe file.
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The Dell OpenManage Server Administrator prerequisite status screen is displayed and runs the prerequisite 
checks for the managed station. Any relevant informational, warning, or error messages are displayed. Resolve all 
error and warning situations, if any.

3. Click the Install, Modify, Repair, or Remove Server Administrator option.
The Welcome to the Install Wizard for Dell OpenManage Server Administrator screen is displayed.

4. Click Next.
The Dell Software License Agreement is displayed.

5. Click I accept the terms in the license agreement and Next if you agree.
The Setup Type dialog box is displayed.

6. Continue the installation from step 8 as mentioned in the Custom Installation section.

Modify

If you want to add or remove Server Administrator components:

1. Navigate to the Windows Control Panel.

2. Click Add/Remove Programs.

3. Click Dell OpenManage Server Administrator and click Change.
The Welcome to the Install Wizard for Dell OpenManage Server Administrator dialog box is displayed.

4. Click Next.
The Program Maintenance dialog box is displayed.

5. Select the Modify option and click Next.
The Custom Setup dialog box is displayed.

6. To select a specific managed system software application, click the drop-down arrow beside the listed feature and 
select either This feature will be installed… to install the feature, or This feature will not be available to ignore the 
feature.
A selected feature has a hard drive icon depicted next to it. A deselected feature has a red X next to it. By default, if 
the prerequisite checker finds a software feature with no supporting hardware, the checker deselects the feature.

7. Click Next to accept the selected software features for installation.
The Ready to Modify the Program dialog box is displayed.

8. Click Install to install the selected software features.
The Installing Dell OpenManage Server Administrator screen is displayed. Messages give the status and progress 
of the software features being installed. When the selected features are installed, the Install Wizard Completed 
dialog box is displayed.

9. Click Finish to exit the Server Administrator installation.
If you are prompted to reboot the system, select from the following reboot options to make the managed system 
software services available for use:

– Yes, reboot my system now.

– No, I will reboot my system later.

NOTE: If you run the installer from another system and try to add a component using the Modify option, the installer 
may display an error. A corrupt source on the system on which you run the installer may have caused the error. 
You can verify this by checking the following registry entry: HKLM\Software\Classes\Installer\Products\<GUID>
\sourcelist\lastusedsource. If the value of lastusedsource is a negative number, it means that the source is corrupt.
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Repair

If you want to repair an installed Server Administrator component that is damaged:

1. Navigate to the Windows Control Panel.
2. Click Add/Remove Programs.
3. Click Dell Server Administrator and click Change.

The Welcome to the Install Wizard for Dell OpenManage Server Administrator dialog box is displayed.

4. Click Next.
The Program Maintenance dialog box is displayed.

5. Select the Repair option and click Next.
The Ready to Repair the Program dialog box is displayed.

6. Click Install to install the selected software features.
The Installing Dell OpenManage Server Administrator screen is displayed and provides the status and progress of 
the software features being installed. When the selected features are installed, the Install Wizard Completed dialog 
box is displayed.

7. Click Finish to exit the Server Administrator installation.
If you are prompted to reboot the system, select from the following reboot options:

– Yes, reboot my system now.
– No, I will reboot my system later.

Uninstalling Managed System Software
You can uninstall managed system software features by using the Dell Systems Management Tools and Documentation 
DVD, or the operating system. You can simultaneously perform unattended uninstallation on multiple systems.

Uninstalling Managed System Software Using Dell-Provided Media

1. Insert the Dell Systems Management Tools and Documentation DVD into the system's DVD drive.
If the setup program does not start automatically, run the setup.exe in the SYSMGMT\srvadmin\windows directory 
on the DVD.
The Dell OpenManage Server Administrator prerequisite status screen is displayed and runs the prerequisite 
checks for the managed system. Any relevant informational, warning, or error messages detected during checking 
are displayed. Resolve all error and warning situations, if any.

2. Click the Install, Modify, Repair, or Remove Server Administrator option.
The Welcome to the Install Wizard for Dell OpenManage Server Administrator screen is displayed.

3. Click Next.
This dialog enables you to modify, repair, or remove the program.
The Program Maintenance dialog box is displayed.

4. Select the Remove option and click Next.
The Remove the Program dialog box is displayed.

5. Click Remove.
The Uninstalling Dell OpenManage Server Administrator screen is displayed and provides the status and progress 
of the software features being uninstalled.
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When the selected features are uninstalled, the Install Wizard Completed dialog box is displayed.

6. Click Finish to exit the Server Administrator uninstallation.
If you are prompted to reboot the system, select from the following reboot options:

– Yes, reboot my system now.

– No, I will reboot my system later.

All Server Administrator features are uninstalled.

Uninstalling Managed System Software Features Using the Operating System

1. Navigate to the Windows Control Panel.

2. Click Add/Remove Programs.

3. Click Dell OpenManage Server Administrator and click Remove.
The Add or Remove Programs dialog box is displayed.

4. Click Yes to confirm uninstallation of Server Administrator.
The Dell OpenManage Server Administrator screen is displayed and provides the status and progress of the 
software features being uninstalled.

If you are prompted to reboot the system, select from the following reboot options:

• Yes, reboot my system now.

• No, I will reboot my system later

All Server Administrator features are uninstalled.

Unattended Uninstall Using the Product GUID

If you do not have the installation DVD or the MSI package available during an uninstallation, use the following 
command line to uninstall Dell OpenManage systems management software on managed systems or management 
stations running Windows operating system. For these cases, use the package GUIDs to uninstall the product.

For managed systems, using the command msiexec.exe /x {E1BCFFAB-7D90-4633-
BDC3-3087F1E00F6D} 

Unattended Uninstallation of Managed System Software

The Dell OpenManage installer features an unattended uninstallation procedure. Unattended uninstallation enables you 
to simultaneously uninstall managed systems software from multiple systems. The unattended uninstallation package is 
distributed to the remote systems using a software distribution tool from an ISV. When the package is distributed, 
the uninstallation script executes to uninstall the software.

Distributing the Unattended Uninstallation Package
The Dell Systems Management Tools and Documentation DVD is pre‑configured to act as the unattended uninstallation 
package. To distribute the package to one or more systems:

1. Configure the ISV distribution software to execute the msiexec.exe /x DVD Drive\SYSMGMT
\srvadmin\windows\SystemsManagement\SysMgmt.msi /qb command, if you are using the DVD, 
after the unattended uninstallation package has been distributed.

2. Use the ISV distribution software to distribute the typical unattended uninstallation package to the remote systems.
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The program executes to uninstall managed systems software on each remote system.

3. Reboot each remote system to complete uninstallation.

Unattended Uninstall Command Line Settings
The Command Line Settings for MSI Installer table shows the unattended uninstall command line settings available for 
unattended uninstallation. Type the optional settings on the command line after msiexec.exe /x SysMgmt.msi 
with a space between each setting.

For example, running msiexec.exe /x SysMgmt.msi /qb runs the unattended uninstallation, and displays the 
unattended uninstallation status while it is running.

Running msiexec.exe /x SysMgmt.msi /qn runs the unattended uninstallation, but silently (without displaying 
messages.)
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4
Installing Managed System Software on 
Supported Linux and VMware ESX
The Dell OpenManage installer supports both 32-bit and 64-bit architecture. The following table explains the operating 
system installation matrix for Dell OpenManage.

Table 9. Operating System Installation Matrix for Dell OpenManage

Operating System Architecture OpenManage 32-bit Architecture OpenManage 64-bit Architecture

Red Hat Enterprise Linux 5.8 64-bit Not supported Install

Red Hat Enterprise Linux 6.2 64-bit Not supported Install

SUSE Linux Enterprise Server (SLES) 
10 SP4 64-bit

Upgrade (Upgrade is supported from 
N-1, N-2, and N-3)

Install or Upgrade (Upgrade is 
supported from N-1 and N- 2)

SUSE Linux Enterprise Server (SLES) 
11 SP 2 64- bit

Not supported Install

ESX 4.0 U3 64-bit Install or Upgrade Not supported

ESX 4.1 U2 64-bit Install or Upgrade Not supported

ESXi 4.0 U3 64-bit Not supported Install

ESXi 4.1 U2 64-bit Not supported Install

ESXi 5.0 U1 64-bit Not supported Install

NOTE: On a Dell OpenManage upgrade, it is recommended to upgrade to the latest open source components 
available on the DVD.

NOTE: With scripted installation using srvadmin-install.sh or Yum repository-based installations, the srvadmin-cm 
RPM that provides 32-bit Inventory Collector does not get installed on a 64-bit operating system. Inventory 
Collector utility feeds software inventory data to management station applications like ITA. If required, install the 
srvadmin-cm package from appropriate subfolders under SYSMGMT/srvadmin/linux/RPMS/supportRPMS/
srvadmin from the Dell Systems Management Tools and Documentation DVD. Since srvadmin-cm RPM requires 32- 
bit version of zlib and compat-libstdc++ libraries, ensure that these libraries are installed on the system.

NOTE: If you are upgrading the operating system to a major version (example, SLES 10 to SLES 11), uninstall the 
existing version of Dell OpenManage and install the supported version.

NOTE: Before you migrate to a 64-bit version of Dell OpenManage software, make sure to uninstall the 32-bit Dell 
OpenManage and other OpenSource components (openwsman-server, openwsman-client, libwsman1, sblim-sfcb, 
sblim-sfcc, libcmpiCppImpl0, libsmbios2, smbios-utils-bin) installed as part of the 32-bit Dell OpenManage.

The installation scripts and RPM packages specific to supported Linux and VMware ESX operating systems are provided 
to install and uninstall the Dell OpenManage Server Administrator and other managed system software components. 
These installation scripts and RPMs are located in the SYSMGMT/srvadmin/linux/supportscripts directory available in 
the Dell Systems Management Tools and Documentation DVD.

The install script srvadmin-install.sh allows silent or interactive installation. By including the srvadmin-install.sh script in 
the Linux scripts, install Server Administrator locally or across a network on single or multiple systems.
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The second install method uses the Server Administrator RPM packages provided in the custom directories and the 
Linux rpm command. Write Linux scripts that install Server Administrator locally or across a network on single or 
multiple systems.

Using a combination of the two install methods is not recommended and may require that you manually install the 
required Server Administrator RPM packages provided in the custom directories, using the Linux rpm command.

For information on supported platforms and supported operating systems, see the Dell Systems Software Support Matrix 
at support.dell.com/manuals.

Software License Agreement
The software license for the Red Hat Enterprise Linux and SUSE Linux Enterprise Server version of the Dell OpenManage 
software is located on the Dell Systems Management Tools and Documentation DVD. Read the license.txt file. 
By installing or copying any of the files on the Dell-provided media, you are agreeing to the terms in this file. This file is 
also copied to the root of the software tree where you install the Dell OpenManage software.

Server Administrator Device Drivers
Server Administrator includes two device drivers for Linux: Systems Management Base Driver (dcdbas) and BIOS 
Update Driver (dell_rbu). Server Administrator uses these drivers to perform the systems management functions on 
supported Linux operating systems. Depending on the system, Server Administrator loads one or both of these drivers if 
required.

The device drivers for Linux are released as open source under the GNU General Public License v2.0. They are available 
in Linux kernels from kernel.org starting with kernel 2.6.14.

If the Server Administrator drivers are available with the operating system, Server Administrator uses those versions of 
the drivers. If the Server Administrator drivers are not available with the operating system, Server Administrator uses its 
Dynamic Kernel Support (DKS) feature to build the drivers when needed.

Dynamic Kernel Support

If required, Server Administrator includes DKS, a feature that Server Administrator uses to build its device drivers 
automatically for a running kernel.
If you see the following message during Server Administrator Device Drivers startup, then Server Administrator has 
attempted to use the DKS feature, but was unable to use the feature because certain prerequisites were not met:
Building <driver> using DKS... [FAILED]

where <driver> is dcdbas or dell_rbu

NOTE: Server Administrator logs messages to the /var/log/messages log file.

To use DKS, identify which kernel is running on the managed system, and check the DKS prerequisites.

Determining the Running Kernel

The system displays a message identifying the running kernel.

1. Log in as root.

2. Type the following command at a console: uname -r 

3. Press <Enter>.
The system displays a message identifying the running kernel.
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Dynamic Kernel Support Prerequisites
For managed system software to use DKS, make sure the following dependencies are met before starting Server 
Administrator.

• The running kernel must have loadable module support enabled.

• The source for building kernel modules for the running kernel is available from /lib/modules/`uname –r`/build. On 
systems running SUSE Linux Enterprise Server, the kernel-source RPM provides the necessary kernel source. 
On systems running Red Hat Enterprise Linux, the kernel-devel RPMs provide the necessary kernel source for 
building kernel modules.

• The GNU make utility is installed. The make RPM provides this utility.

• The GNU C compiler (gcc) is installed. The gcc RPM provides this compiler.

• The GNU linker (ld) is installed. The binutils RPM provides this linker.

When these prerequisites have been met, DKS automatically builds a device driver when needed during Server 
Administrator startup.

Using Dynamic Kernel Support After Server Administrator Installation
To enable Server Administrator to support a kernel that is not supported by a precompiled device driver and is loaded 
after Server Administrator has been installed, ensure that the DKS prerequisites are met on the managed system and 
boot the new kernel on the system.

Server Administrator builds a device driver for the kernel running on the system the first time Server Administrator starts 
after the kernel is loaded. By default, Server Administrator starts during system startup.

Copying a Dynamically Built Device Driver to Systems Running the Same Kernel

When the Server Administrator dynamically builds a device driver for the running kernel, it installs the device driver in 
the /lib/modules/<kernel>/kernel/drivers/firmware directory, where<kernel> is the kernel name (returned by typing 
uname -r). If you have a system running the same kernel for which a device driver was built, copy the newly built 
device driver to the /var/omsa/dks/<kernel> directory on the other system for the Server Administrator. This allows the 
Server Administrator to use DKS on multiple systems without having to install the kernel source on every system.

For example, System A is running a kernel that is not supported by one of the Server Administrator precompiled device 
drivers. System B is running the same kernel. Perform the following steps to build a device driver on system A and copy 
the device driver to system B for use by Server Administrator:

1. Ensure that the DKS prerequisites are met on system A.

2. Start Server Administrator on system A.
Server Administrator builds a device driver for the kernel running on system A during startup.

3. Type uname -r on system A to determine the name of the running kernel.

4. Copy any dcdbas.* or dell_rbu.* files in the /lib/modules/<kernel>/kernel/drivers/firmware directory on system A to 
the /var/omsa/dks/<kernel> directory on system B, where <kernel> is the kernel name returned by typing uname -
r in step 3.

NOTE: The /lib/modules/<kernel>/kernel/drivers/firmware directory may contain one or more of the following files: 
dcdbas.* or dell_rbu.*.

NOTE: Create the /var/omsa/dks/<kernel> directory on system B. For example, if the kernel name is 1.2.3-4smp, 
create the directory by typing mkdir‑p/var/omsa/dks/1.2.3‑4smp.

5. Start Server Administrator on system B.

NOTE: When you have uninstalled Server Administrator from system B, the /var/omsa/dks/<kernel>/*. files that you 
copied to system B are not removed. Remove the files if they are no longer needed.
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Server Administrator detects that the device driver you copied to the /var/omsa/dks/<kernel> directory supports the 
running kernel and uses that device driver.

OpenIPMI Device Driver
The Server Instrumentation feature of Server Administrator requires the OpenIPMI device driver that provides IPMI-
based information and functionality.

All supported Linux systems contain the required version of IPMI module in the default kernel itself. You do not have to 
install the IPMI RPM. For more information on supported systems, see the Dell Systems Software Support Matrix 
available at support.dell.com/manuals.

Degradation of Functionality When the Server Administrator Instrumentation Service is 
Started

After Server Administrator is installed, the Server Administrator Instrumentation Service performs a run‑time check of 
the OpenIPMI device driver whenever it is started. The Server Administrator Instrumentation Service is started 
whenever you run either the srvadmin-services.sh start or srvadmin‑services.sh restart commands, or when you restart 
the system (during which the Server Administrator Instrumentation Service is started.)

Server Administrator installation blocks the installation of Server Administrator packages if an appropriate version of the 
OpenIPMI device driver is not currently installed on the system. However, it is still possible, though not typical, that you 
can uninstall or replace a sufficient version of the OpenIPMI device driver after Server Administrator has been installed. 
Server Administrator cannot prevent this.

To account for a user uninstalling or replacing a sufficient version of the OpenIPMI device driver after Server 
Administrator has been installed, the Server Administrator Instrumentation Service checks the OpenIPMI device driver 
version whenever it is started. If a sufficient version of the OpenIPMI device driver is not found, the Server Administrator 
Instrumentation Service degrades itself so that it does not provide any of the IPMI-based information or functionality. 
Primarily, this means that it does not provide any probe data (for example, fans, temperatures, and voltage probe data.)

Installing Managed System Software
This section explains how to install managed system software using the following installation options:

• Using the srvadmin-install.sh shell script

NOTE: If you have downloaded the managed system software installer (available as a .tar.gz file) from 
support.dell.com, the srvadmin-install.sh shell script is present as setup.sh in the root directory.

• Using the RPM command

Related Links:

Deployment Scenarios for Server Administrator

Prerequisites for Installing Managed System Software

The prerequisites are:

• Log in as root.

• The running kernel must have loadable module support enabled.

• The /opt directory must have at least 250 MB of free space, and the /tmp, /etc, and /var directories must each 
have at least 20 MB of free space.
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• Install the ucd-snmp or net-snmp package that is provided with the operating system if you use SNMP to 
manage the server. If you want to use supporting agents for the ucd-snmp or net-snmp agent, you must install 
the operating system support for the SNMP standard before you install Server Administrator. For more 
information about installing SNMP, see the installation instructions for the operating system you are running on 
the system.

NOTE: When installing RPM packages, to avoid warnings concerning the RPM–GPG key, import the key with a 
command similar to rpm --import <OM DVD mountpoint>/SYSMGMT/srvadmin/linux/RPM-
GPG-KEY

• In case of Red Hat Enterprise Linux 6.2 and above and SLES 11 SP2, install the wsman and sblim packages from 
the operating system DVD. See, To install the wsman and sblim packages

• Install all the prerequisite RPMs required for successful installation.
If the system had VMware ESX (version 4.0 or 4.1) factory-installed, Red Hat Enterprise Linux (versions 5.x and 
6.0), or SUSE Linux Enterprise Server (version 10 and 11), see the Dependent RPMs for Remote Enablement 
section for information on any RPMs that you need to manually install prior to installing managed system 
software. Typically, you may not need to manually install any RPMs.

Installing the wsman and sblim packages

1. In Package selection, select Basic Server.

2. Select Customize now and click Next.

3. Select System Management group.

4. From the sub-category, select Web-based Enterprise Management → Optional Packages option. The default 
selected packages are: openwsman-client, sblim-sfcb, sblim-wbemcli, and wsmancli
Deselect the sblim-wbemcli package from the above list.

5. Select openwsman-server and click Next.

6. After the operating system installation, install libcmpiCppImpl0 package from the operating system DVD or using 
the Yum utility.

Installing Managed System Software Using Dell-Provided Media

The Dell OpenManage installer uses RPMs to install each component. The media (DVD) is divided into subdirectories to 
enable easy custom installation.

NOTE: On the Red Hat Enterprise Linux 5.x operating system, DVDs are auto-mounted with the -noexec mount 
option. This option does not allow you to run any executable from the DVD. Manually mount the DVD and then run 
executables.

To review the software before you install it, follow this procedure:

1. Load the Dell Systems Management Tools and Documentation DVD into the system's DVD drive.

2. Mount the DVD, if required.

3. When you have mounted the DVD, navigate to: <OM DVD mount point>/SYSMGMT/srvadmin/linux/
The installation script and RPM folder are available under the Linux directory.

Express Install

Use the provided shell script to perform the express installation on supported Linux and VMware ESX operating systems.

NOTE: On the Red Hat Enterprise Linux 5.x operating system, DVDs are auto‑mounted with the -noexec mount 
option. This option does not allow you to run any executable from the DVD. Manually mount the DVD and then run 
executables.
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1. Log in as root to the system running the supported operating system where you want to install the managed 
system components.

2. Insert the Dell Systems Management Tools and Documentation DVD into the DVD drive.
3. Mount the DVD, if required.
4. Navigate to <OM DVD mount point>/SYSMGMT/srvadmin/linux/supportscripts directory. Run the srvadmin-

install.sh shell script, which performs an express installation.
sh srvadmin-install.sh --express

or
sh srvadmin-install.sh -x

The setup program installs the following managed system software features:

– Server Administrator Web Server

– Server Instrumentation

– Storage Management

– Remote Access Controller

Remote enablement is not installed and Server Administrator services do not start automatically.

NOTE: The 32-bit srvadmin-cm RPM is not installed when OpenManage is installed on a 64-bit operating system. If 
required, install the srvadmin-cm package from the appropriate subfolders under SYSMGMT/srvadmin/linux/
RPMS/supportRPMS/srvadmin from the Dell Systems Management Tools and Documentation DVD. Inventory 
Collector utility carried as part of srvadmin-cm rpm feeds software inventory data to Dell Management Station 
applications like ITA.

5. Start the Server Administrator services after the installation using the srvadmin-services.sh script by using the sh 
srvadmin-services start command.

Component Specific Install Using RPM Commands
The RPMs specific to a particular OpenManage component are grouped together. To facilitate an RPM-based 
installation, install the RPMs from the following directories:

• SYSMGMT/srvadmin/linux/custom/<OS>/Remote-Enablement/< arch>

• SYSMGMT/srvadmin/linux/custom/<OS>/SA-WebServer/<arch>

• SYSMGMT/srvadmin/linux/custom/<OS>/Server-Instrumentation/<arch >

• SYSMGMT/srvadmin/linux/custom/<OS>/add-RAC4/<arch>

• SYSMGMT/srvadmin/linux/custom/<OS>/add-RAC5/<arch>

• SYSMGMT/srvadmin/linux/custom/<OS>/add-StorageManagement/< arch>

• SYSMGMT/srvadmin/linux/custom/<OS>/add-iDRAC/<arch>

Where <OS> is the supported operating system and <arch> is 32-bit (i386) or 64-bit (x86_64).

NOTE: In case of SUSE Linux Enterprise Server version 10 and 11: 32-bit Dell OpenManage rpm packages are 
provided for upgrade from the previous 32-bit installs only. If you do not have an existing installation, then you 
cannot install a 32-bit version of the software. You must install operating system specific rpms from the 64-bit 
directory.

For example, if you are running Red Hat Enterprise Linux version 5, you can customize the installation by adding the 
RPMs from the following directories:
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Table 10. RPM Directory

Directory RPM Package

SYSMGMT/srvadmin/linux/custom/ RHEL5/add-
StorageManagement/<arch>

Storage Management component packages

SYSMGMT/srvadmin/linux/custom/ RHEL5/SAWebServer/
<arch>

Server Administrator Web Server component packages

SYSMGMT/srvadmin/linux/custom/ RHEL5/Server-
Instrumentation/<arch>

Server Instrumentation packages

The DVD provides RPMs that enable repository-based installation using clients such as Yum, Zypper, and Rug. There are 
RPMs that install the entire set or you can select individual RPMs to install specific components. The RPMs are 
available at:
SYSMGMT/srvadmin/linux/RPMS/supportRPMS/metaRPMS

The following list of RPMs enables the installation of a particular RPM set.
Table 11. Meta RPMs

Meta RPMs Details

srvadmin-all Installs all the components.

srvadmin-base Installs the Server Instrumentation component. This 
component has to be installed before installing any of the 
other specific components.

srvadmin-idrac Installs the iDRAC component.

srvadmin-rac4 Installs the DRAC 4 component.

srvadmin-rac5 Installs the DRAC 5 component.

srvadmin-standardAgent Installs the Remote Enablement component.

srvadmin-storageservices Installs the storage services component.

srvadmin-webserver Installs the web server component.

Related Links:

Dell OpenManage Linux Installer Packages

Custom RPMs based installation
The following is an example of custom RPMs-based installation of Server Administrator, including the installation of the 
Remote Enablement feature and the Storage Management Service components.

NOTE: On the Red Hat Enterprise Linux 5.x operating system, DVDs are automounted with the -noexec mount 
option. This option does not allow you to run any executable from the DVD. You have to manually mount the DVD 
and then run executables.

1. Log in as root to the system running the supported operating system where you want to install the managed 
system components.

2. Insert the Dell Systems Management Tools and Documentation DVD into the DVD drive.
3. Navigate to the operating system specific directory corresponding to the system.
4. Type the following command:

rpm –ivh Server-Instrumentation/<arch>/*.rpm 
add-StorageManagement/<arch>/*.rpm 
RemoteEnablement/<arch>/*.rpm

Server Administrator services do not start automatically.
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NOTE: Ensure that you install Server Instrumentation or Remote Enablement before installing Remote Access 
Controller or Storage Management.

NOTE: If you choose to install the Remote Enablement feature, ensure that you install the dependent RPMs before 
installing this feature.

5. Start the Server Administrator services after the installation by using the command:
sh srvadmin-services start

NOTE: You can install Server Administrator on any system that meets operating system dependencies. However, 
after installation, certain Server Administrator services may not be started on unsupported systems.

NOTE: When Dell OpenManage Server Administrator is installed on a system, dependency issues related to RPMs 
may occur. To resolve these issues, install the missing RPMs from SYSMGMT/srvadmin/linux/RPMS/supportRPMS/
opensourcecomponents. If the RPMs are not available in this directory, install these RPMs from the operating 
system media. If not available on the media, search for these RPMs on the Internet.

Related Links:

Dependent RPMs for Remote Enablement

Using the Shell Script to Perform the Custom Installation
You can run the Server Administrator Custom Install script in an interactive mode.

The basic usage of the script is:
srvadmin-install.sh [OPTION]...

Server Administrator Custom Installation Utility

This utility runs in interactive mode if you do not specify any options, and runs silently if you provide one or more options.

The options are:

• [-x|--express] — Installs all components (including RAC, if available) any other options passed are ignored.
• [-d|--dellagent] — Installs Server Instrumentation components.
• [-c|--cimagent] — Installs Remote Enablement components.
• [-s|--storage] — Installs Storage Management, including Server Instrumentation.
• [-r|--rac] — Installs applicable RAC components, including Server Instrumentation.
• [-w|--web] — Installs Server Administrator Web Server.
• [-u|--update] — Updates applicable Server Administrator components.
• [-h|--help] — Displays the help text.
• [-p|--preserve] — Preserves the screen without clearing off.

NOTE: If you do not use the [-p | --preserve] option during the installation, the history information on the screen 
gets cleared off.

• [-a|--autostart] — Starts the installed services after components have been installed.

Using the Shell Script to Perform the Installation in Interactive Mode

This installation procedure uses the srvadmin-install.sh to prompt you for the installation of specific 
components.

1. Log in as root to the system running the supported operating system where you want to install the managed 
system components.

2. Insert the Dell Systems Management Tools and Documentation DVD into the DVD drive.
3. Mount the DVD, if required.
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4. Navigate to <OM DVD mount point>/SYSMGMT/srvadmin/linux/supportscripts.

5. Execute the script with the sh srvadmin-install.sh command and accept the terms of the end-user 
license agreement.
Executing the command displays a list of component options. If any of the components are already installed, then 
those components are listed separately with a check mark next to them. The Server Administrator installation 
options are displayed.

6. Press <c>to copy, <i> to install, <r> to reset and start over, or <q> to quit. If you press <c>, you are prompted to 
enter the absolute destination path.
When the installation is complete, the script has an option for starting the services.

7. Press <y>to start the services or <Enter> to exit.

Using the Install Script To Run in the Silent Mode

Perform these steps for a silent installation using the srvadmin‑install.sh shell script:

1. Log in as root to the system running the supported operating system where you want to install the managed 
system components.

2. Insert the Dell Systems Management Tools and Documentation DVD into the DVD drive.

3. Mount the DVD, if required.

4. Navigate to <OM DVD mount point>/SYSMGMT/srvadmin/linux/supportscripts.

5. To install the Storage Management Service components, type the command sh srvadmin-install.sh --
storage (long options) OR sh srvadmin-install.sh -s (short options)

NOTE: Long options can be combined with short options, and vice-versa.

6. Start Server Administrator services after the installation by typing the command sh srvadmin-services 
start.

NOTE: After installing Server Administrator, log out and then log in again to access the Server Administrator 
Command Line Interface (CLI).

Determining the OpenManage Server Administrator Architecture
Use the following command to identify if the already installed OpenManage Server Administrator is of 32-bit or 64-bit 
architecture
rpm -q --queryformat "%{NAME} - %{ARCH}\n"  `rpm -qa | grep srvadmin` 

The system displays a message identifying the architecture where, i386 refers to 32-bit and x86_64 refers to 64-bit.

Managed System Software Installation Using Third Party Deployment Software

Use third-party deployment software, such as Altiris Deployment Solution, to install managed systems software on 
supported Dell systems. To distribute and install Server Administrator using Altiris, start the Altiris application and import 
OpenManage_Jobs.bin located at SYSMGMT\srvadmin\support\Altiris on the Dell Systems Management Tools and 
Documentation DVD. Specify a job folder to import OpenManage_Jobs.bin. Modify the Run Script and Copy File tasks to 
match the deployment environment. When complete, schedule the job to run on the supported Dell systems that are 
managed from the Altiris Deployment Solution.
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Uninstalling Managed System Software
To uninstall Managed System Software, log in as root.

Uninstalling Managed System Software Using the Uninstall Script

An uninstallation script is installed when you install Server Administrator. Execute the script by typing srvadmin-
uninstall.sh and then pressing <Enter>.

Uninstalling Managed System Software Using the RPM Command

The individual components of Dell OpenManage can be uninstalled without uninstalling all of Dell OpenManage.

To uninstall only the Server Administrator Web Server, use the command rpm –e `rpm -qa | grep 
srvadmin-tomcat`.

During an uninstallation, files in which user settings are made are preserved with the .rpmsave file extension. Log files 
are also preserved after the uninstallation.
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5
Installing Managed System Software On 
Microsoft Windows Server 2008 Core and 
Microsoft Hyper-V Server
The Server Core installation option of the Microsoft Windows Server 2008 and Hyper-V Server operating system 
provides a minimal environment for running specific server roles that reduce the maintenance and management 
requirements and the attack surface for those server roles. A Windows Server 2008 Core or Hyper-V Server installation 
installs only a subset of the binaries that are required by the supported server roles. For example, the Explorer shell is 
not installed as part of a Windows Server 2008 Core or Hyper-V Server installation. Instead, the default user interface for 
a Windows Server 2008 Core or Hyper-V Server installation is the command prompt.

NOTE: Windows Server 2008 Core or Hyper-V Server operating system does not support a graphical user interface 
(GUI) based installation of Dell OpenManage software components. Install OpenManage software in the Command 
Line Interface (CLI) mode on Server Core. For more information on Server Core, see microsoft.com.

NOTE: On Windows 7, to install the systems management software successfully, log in using an account which 
belongs to the Administrators Group and must execute the setup.exe using the option Run as administrator from 
the right-click menu.

NOTE: Log in as a built-in administrator to install the systems management software on Windows Server 2008 and 
Windows Vista. For more information about the built-in Administrator account, see the Windows Server 2008 Help.

Running Prerequisite Checker In CLI Mode
You must run the prerequisite checker in the CLI mode as Windows Server 2008 and Hyper-V Server does not support 
the GUI mode.

Related Links:

Prerequisite Checker

Installing Managed System Software in CLI Mode
Launch the MSI file from the command prompt using the command msiexec /i SysMgmt.msi. The MSI file 
SysMgmt.msi is located at SYSMGMT\srvadmin\windows\SystemsManagement on the Dell Systems Management Tools 
and Documentation DVD.

To install the localized version of the managed system software, type
msiexec /I SysMgmt.msi TRANSFORMS= <languauge_transform >.mst

in the command prompt. Replace <language_transform >.mst with the appropriate language file:

• 1031.mst (German)
• 1034.mst (Spanish)
• 1036.mst (French)
• 1041.mst (Japanese)
• 2052.mst (Simplified Chinese)
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Related Links:

Optional Command Line Settings

Uninstalling Systems Management Software
To uninstall managed system software, type msiexec /x sysmgmt.msi in the command prompt.
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6
Installing Dell OpenManage Software on 
VMware ESXi
VMware ESXi is factory-installed on some Dell systems. For a list of these systems, see the latest Dell Systems Software 
Support Matrix at support.dell.com/manuals. Use Server Administrator Web Server version 7.0 to access VMware ESXi 
4.0 U3, VMware ESXi 4.1 U2, VMware ESXi 5.0 U1 systems.
Dell OpenManage Server Administrator is available as a .zip file for installing on systems running VMware ESXi. The zip 
file, OM-SrvAdmin-Dell-Web-7.1.0-<bldno>.VIB-ESX<version>i_<bld-revno>.zip, where <version> is the supported ESXi 
version, is available for download at support.dell.com.

Download VMware vSphere Command Line Interface (vSphere CLI) from vmware.com and install on the Microsoft 
Windows or Linux system. Alternately, you can import VMware vSphere Management Assistant (vMA) to the ESXi host.

Using the vSphere CLI
To install Dell OpenManage software on VMware ESXi using the vSphere CLI:

1. Copy and unzip the OM-SrvAdmin-Dell-Web-7.1.0-<bldno>.VIB-ESX<version>i_<bld-revno>.zip file to a directory on 
the system. For ESXi 5.0 and ESXi 5.0 P1, copy the unzipped file to the /var/log/vmware folder on the ESXi 5.0 U1 
server.

NOTE: For ESX 4.x, you do not have to unzip the file.

2. Shut down all guest operating systems on the ESXi host and put the ESXi host in maintenance mode.
3. If you are using vSphere CLI on Windows, navigate to the directory where you have installed the vSphere CLI 

utilities.
If you are using vSphere CLI on Linux, execute the command from any directory.

4. Execute the following command:
For VMware ESXi4.0/ESXi 4.1: vihostupdate.pl --server<IP address of ESXi host>-i -b 
<path to Dell OpenManage file> 
For VMware ESXi 5.0 U1: esxcli --server <IP Address of ESXi 5.0 host> software vib 
install -d /var/log/vmware/<Dell OpenManage file>
NOTE: The .pl extension is not required if you are using vSphere CLI on Linux.

5. Enter the root username and password of the ESXi host when prompted.
The command output displays a successful or a failed update.

6. Restart the ESXi host system.

To get or list the information about the installed VIBs:

• For ESXi 4.x, use vihostupdate.pl --server <IP> --query or -q
• For ESXi 5.x, use esxcli --server <IP>software vib get or software vib list

The VIB contains the following items:

• Server Administrator Instrumentation Service
• Remote Enablement
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• Server Administrator Storage Management

• Remote Access Controller

Related Links:

Troubleshooting

Using the VMware vSphere Management Assistant (vMA)
The vMA allows administrators and developers to run scripts and agents to manage ESX/ESXi systems. For more 
information on vMA, see vmware.com/support/developer/vima/.

1. Log on to vMA as an administrator and provide the password when prompted.

2. Copy and unzip the OM-SrvAdmin-Dell-Web-7.1.0-<bldno>.VIB-ESX<version>i_<bld-revno>.zip file to a directory on 
the vMA.

3. Shut down all guest operating systems on the ESXi host and put the ESXi host in maintenance mode.

4. In vMA, execute the following command:
For VMware ESXi4.0/ESXi 4.1: vihostupdate --server <IP address of ESXi Host> -i -b 
<path to Dell OpenManage file>
For VMware ESXi 5.0 U1: esxcli --server <IP Address of ESXi 5.0 host> oftware vib 
install -d /var/log/vmware/<Dell OpenManage file>

5. Enter the root username and password of the ESXi host when prompted.
The command output displays a successful or a failed update.

6. Restart the ESXi host system.

When you run the command, the following components are installed on the system:

• Server Administrator Instrumentation Service

• Remote Enablement

• Server Administrator Storage Management

• Remote Access Controller

Install the Server Administrator Web Server separately on a management station.

After installing Server Administrator, enable the Server Administrator Services.

Related Links:

• Troubleshooting

• Installing Managed System Software on Microsoft Windows Operating Systems 

• Installing Managed System Software on Supported Linux and VMware ESX

• Enabling Server Administrator Services on the Managed System

Using the VMWare Update Manager (VUM)
To install Server Administrator using VUM:

1. Install VMware vSphere 5.x (vCenter Server, vSphere Client, and VMware vSphere Update Manager) on a 
Windows 2008 R2 SP1 64-bit server.

2. On the desktop, double-click VMware vSphere Client and login to vCenter Server.

3. Right-click vSphere Client host and click New Datacenter.

4. Right-click New Datacenter and click Add Host. Provide information for the ESXi server per online instructions.
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5. Right-click the ESXi host added in the previous step and click Maintenance Mode.

6. From Plug-ins select Manage Plug-ins → download VMware Update Manager (The status is enabled if the 
download is successful.) Follow the instructions to install the VUM client.

7. Select the ESXi host. Click Update Manager → Admin view → Patch Repository → Import Patches and follow the 
online instructions to upload the patch successfully.
The offline bundle is displayed.

8. Click Baselines and Groups.

9. Click create from Baselines tab, mention baseline name and select Host Extension as baseline type. Complete the 
rest as per instructions.

10. Click Admin View.

11. Click Add to Baseline (against the uploaded patch name) and select the baseline name that you have created in 
step 8.

12. Click Compliance view. Select the Update Manager tab. Click Attach and select the Extension Baseline created in 
step 8 and follow the instructions.

13. Click Scan and select Patches & Extensions (if not selected by default) and click on Scan.

14. Click Stage, select created Host Extension and follow the instructions.

15. Click Remediate and follow the instructions once the staging is completed.
Server Administrator installation is complete.

16. Reboot the host.

Using the Power CLI
To install Server Administrator using Power CLI:

1. Install the supported PowerCLI of ESXi on Windows System.

2. Copy the OM-SrvAdmin-Dell-Web-7.1.0-<bldno>.VIB-ESX<version>i_<bld-revno>.zip file to the ESXi host.

3. Navigate to the bin directory.

4. Run Connect-VIServer and provide the server and other credentials.

5. Log on to the ESXi host using supported vSphere CLI of ESXi 5.0 U1 and create a datastore.

6. Create a folder OM-SrvAdmin-Dell-Web-7.1.0-<bldno>.VIB-ESX<version>I on ESXi 5.0 U1 host under /vmfs/volumes/
<datastore_name> directory.

7. Copy the ESXi zip file on ESXi 5.0 U1 host to/vmfs/volumes/<datastore_name>OM-SrvAdmin-Dell-Web-7.1.0-
<bldno>.VIB-ESX<version>I directory.

8. Unzip the zip file in the above specified directory.

9. Run the following command in Power CLI Install-VMHostPatch -VMHost 10.94.171.97 - 
HostPath /vmfs/volumes/<datastore_name>name>/OMSrvAdmin- Dell-Web-7.1.0-
<build ID>.VIBESX<version>i/ cross_oem-dell-openmanage-esxi_7.1-0000- 
metadata.zip

10. Reboot the ESXi host.

11. Run the following command to check if OpenManage is installed successfully on the host. esxcli software 
vib list|grep -i open
OpenManage is displayed.

Enabling Server Administrator Services on the Managed System
The Server Administrator Web Server communicates with the VMware ESXi system through the Server Administrator 
Common Interface Model (CIM) provider. The Server Administrator CIM provider is an Original Equipment Manufacturer 
(OEM) provider on the VMware ESXi system. CIM OEM providers are disabled by default on VMware ESXi 4.0 and ESXi 
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4.1. Enable the CIM OEM providers on the VMware ESXi system before accessing it using Server Administrator Web 
Server.

NOTE: In ESXi 4.1 U2, ESXi 5.0 U1 Dell OpenManage CIM OEM provider is enabled by default.

Enabling CIM OEM Providers Using vSphere Client (for VMware ESXi4.0/ESXi 4.1)

To enable CIM OEM providers using VMware vSphere Client, you must have the vSphere Client tool installed. You can 
download and install the tool from https://<IP_address of ESXi host> where <ip_address> is the IP address of the 
VMware ESXi system.

To enable CIM OEM providers on the VMware ESXi system using vSphere Client:

1. Log on to the VMware ESXi host system using vSphere Client.

2. Click the Configuration tab.

3. Under the Software section on the left side, click Advanced Settings.

4. In the Advanced Settings dialog box, click UserVars on the left pane.

5. Change the value of the CIMOEMProvidersEnabled (for ESXi 4.0) or CIMoemProviderEnabled (for ESXi 4.1) field to 1.

6. Click OK.

7. For the changes to take effect without restarting the system, use the Restart Management Agents option in the 
Direct Console User Interface (DCUI) on the local console of the VMware ESXi system.

NOTE: This option is available under Troubleshooting Options in ESXi 4.1.

If the changes are not effective and you cannot connect to the VMware ESXi host using Server Administrator, 
restart the VMware ESXi host system.

Enabling CIM OEM Providers Using vSphere CLI (for VMware ESXi 4.0/ESXi 4.1)

To enable CIM OEM providers on the VMware ESXi system using vSphere CLI:

1. If you are using vSphere CLI on Windows, navigate to the directory where you have installed the vSphere CLI 
utilities. On Linux, proceed to step 2.

2. Execute the command vicfg-advcfg.pl --server <ip_address of ESXi host> --username 
<user_name> --password <password> --set 1 UserVars.CIMOEMProvidersEnabled
NOTE: For ESXi 4.0, use CIMOEMProvidersEnabled and for ESXi 4.1, use CIMoemProviderEnabled.

The .pl extension is not required if you are using vSphere CLI on Linux.

3. For the changes to take effect without restarting the system, use the Restart Management Agents option in the 
DCUI on the local console of the VMware ESXi system.

NOTE: This option is available under Troubleshooting Options in ESXi 4.1.

If the changes are not effective and you cannot connect to the VMware ESXi host using Server Administrator, 
restart the VMware ESXi host system.

Enabling CIM OEM Providers Using vMA (for VMware ESXi 4.0/ESXi 4.1)

To enable CIM OEM providers on the VMware ESXi system using vMA:
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1. Log in to the vMA as an administrator and provide the password when prompted.

2. Execute the command vicfg-advcfg --server <ip_address of ESXi host> --username 
<user_name> --password <password> --set 1 UserVars.CIMOEMProvidersEnabled
NOTE: For ESXi 4.0, use CIMOEMProvidersEnabled and for ESXi 4.1, use CIMoemProviderEnabled.

3. For the changes to take effect without restarting the system, use the Restart Management Agents option in the 
DCUI on the local console of the VMware ESXi system.
If the changes are not effective and you cannot connect to the VMware ESXi host using Server Administrator, 
restart the VMware ESXi host system.

Uninstalling the Existing OpenManage VIB

To uninstall the existing OpenManage VIB:

1. Run the following command to uninstall the VIB:

On ESXi 4.x: vihostupdate.pl --server <IP> -r -B <VIB Name>

On ESXi 5.x: esxcli  --server <IP> software vib remove <VIB Name>

2. Reboot the system after uninstalling.

Configuring the SNMP Agent on Systems Running VMware ESXi
Server Administrator generates Simple Network Management Protocol (SNMP) traps in response to changes in the 
status of sensors and other monitored parameters. You must configure one or more trap destinations on the system 
running Server Administrator to send SNMP traps to a management station.
Server Administrator supports SNMP traps on VMware ESXi but does not support SNMP Get and Set operations 
because VMware ESXi does not provide the required SNMP support. You can use the VMware vSphere CLI to configure 
VMware ESXi to send SNMP traps to a management application such as IT Assistant.

NOTE: For more information about using the VMware vSphere CLI, see the VMware support site at vmware.com/
support.

Configuring the System to Send Traps to a Management Station Using the vSphere CLI

Server Administrator generates SNMP traps in response to changes in the status of sensors and other monitored 
parameters. One or more trap destinations must be configured on the system running Server Administrator to send 
SNMP traps to a management station.

Configure the ESXi system running Server Administrator to send traps to a management station:

1. Install the VMware vSphere CLI.

2. Open a command prompt on the system in which the vSphere CLI is installed.

3. Navigate to the directory in which the vSphere CLI is installed. The default location on Linux is /usr/bin and on 
Windows is C:\Program Files\VMware\VMware vSphere CLI\bin.

4. Configure the SNMP setting using the command: vicfg-snmp.pl --server <server> --username 
<username> --password <password> -c <community> -t <hostname>@162/
<community>
where <server> is the hostname or IP address of the ESXi system, <username> is a user on the ESXi system, 
<password> is the password of the ESXi user, <community> is the SNMP community name and <hostname> is the 
hostname or IP address of the management station.
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NOTE: If you do not specify a user name and password, you are prompted to specify the same.

5. Enable SNMP using the command: vicfg-snmp.pl --server <server> --username <username> 
--password <password> -E

6. View the SNMP configuration using the command: vicfg-snmp.pl --server <server> --username 
<username> --password <password> -s

7. Test the SNMP configuration using the command: vicfg-snmp.pl --server <server> --username 
<username> --password <password> -T
NOTE: The .pl extension is not required if you are using vSphere CLI on Linux or using vMA.

The SNMP trap configuration takes effect immediately without restarting any services.

Troubleshooting
• When attempting to use the vihostupdate command, the following error may be displayed:

unpacking c:\OM-SrvAdmin-Dell-Web-7.1.0-<bldno>.VIB-ESX<version>i_<bld-
revno>.zip
metadata.zip.sig does not exist
signature mismatch : metadata.zip
Unable to unpack update package.

This error is displayed if you are using an older version of the Remote CLI. To resolve this issue, download and 
install the latest vSphere version of the CLI.

• When attempting to use the vihostupdate command, the following error may be displayed:
Unable to create, write or read a file as expected.I/O Error (28) on 
file : [Errno 28] No space left on device.

See the VMware KB article 1012640 at kb.vmware.com to fix this error.
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7
Installing Dell OpenManage Software on Citrix 
XenServer 
The Dell OpenManage Server Administrator is installed on Citrix XenServer using the Dell OpenManage Supplemental 
Pack. The OpenManage Supplemental Pack for Citrix XenServer 6.0 can be installed in two ways:

• During the installation of XenServer
• On a running system

During the installation of XenServer
To install the OpenManage Supplemental Pack for Citrix XenServer 6.0 during the installation of XenServer:

1. Start the installation of XenServer as usual and follow the instructions on the screen.
2. One of the early questions during the installation process of XenServer is if you want to install any Supplemental 

Packs; click Yes and continue with the installation process.
3. After the base XenServer image is installed (5-10 minutes depending on the speed of the system), you are prompted 

to insert the Supplemental Pack CD. Eject the XenServer installation CD from the optical drive, insert the Dell 
OpenManage Supplemental Pack CD and click OK. The message OpenManage Supplemental Pack was 
found is displayed. To confirm installation, click Use and click OK.

NOTE: If you have more than one Supplemental Pack, (either the Linux Supplemental Pack from Citrix or other 
third-party applications) you can install them in any order, although it is recommended that you install the Dell 
OpenManage Supplemental Pack last.

4. After completing the Dell OpenManage Supplemental Pack installation (2-5 minutes, depending on the speed of the 
system), you are prompted to install other Supplemental Packs. If you do not want to install other supplemental 
packs, click Skip and press <Enter>. The XenServer is installed successfully.

NOTE: When installing RPM packages, to avoid warnings concerning the RPM–GPG key, import the key with a 
command similar to the following:

rpm --import<OM DVD mountpoint>SYSMGMT/srvadmin/linux/RPM-GPG-KEY

On a Running System
To install the OpenManage Supplemental Pack for Citrix XenServer 6.0 on a running system:

1. Burn the Supplemental Pack ISO file to a CD/DVD or download the ISO file to the server.
If you are downloading the ISO file, mount it on a temporary directory as follows:
$ mount -o loop <openmanange-supplemental-pack-filename>.iso /mnt

If you burned the ISO file to a CD/DVD, insert it in the optical drive and run:
$ mount /dev/cdrom /mnt

2. Install the supplemental pack:
$ cd /mnt
$ ./install.sh
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OR
$ xe-install-supplemental-pack <openmanange-supplemental-pack-filename>.iso

NOTE: If a previous version of OpenManage is already installed on the system, then the command to upgrade it to 
version 7.0 is ./install.sh.

After the installation or upgrade of OpenManage, execute the following post-installation configuration script of 
Remote Enablement feature
$ cd  /opt/dell/srvadmin/etc
$ ./autoconf_cim_component.sh  -p  5986

3. When the installation is complete, unmount the ISO file or CD:
$ cd ..
$ umount /mnt

CAUTION: Removal of the Dell OpenManage Supplemental Pack or any Dell OpenManage RPMs is not supported 
by Dell or Citrix and it is not recommended. Manual removal of any RPM leaves the system in an inconsistent state 
which could make any potential issue debugging effort difficult or impossible. A future Supplemental Pack release 
supports removal of the Dell OpenManage Supplemental Pack.

XenServer Upgrade
If the XenServer image is upgraded to a newer XenServer update or release, the Dell OpenManage Supplemental Pack 
must be reinstalled since the new XenServer image is placed on a different partition from the original. In this case, 
follow the same installation instructions as before. However, any Dell OpenManage configuration settings saved on the 
server is lost.

For more information on using Dell OpenManage with Citrix XenServer Dell Edition, see the Citrix XenServer Dell Edition 
Solution Guide at support.dell.com/support/edocs/software/Citrix/.

NOTE: If you are connecting to a XenServer 6.0 managed node using server administrator web server, use port 
5986 in the format Hostname:Port Number, or IP address:Port Number.

Post Installation Tasks
After the installation or upgrade of OpenManage:

1. Execute the post installation configuration scripts of Remote Enablement feature:
$ cd /opt/dell/srvadmin/etc
$ ./autoconf_cim_component.sh -p 5986

2. Restart openwsman and sfcb services:
$   /etc/init.d/openwsmand restart
$   /etc/init.d/sfcb restart

3. Open the port 5986:
$  iptables -I RH-Firewall-1-INPUT -p tcp --destination-port 5986 -j ACCEPT

4. Start the Server Administrator services:
$ sh srvadmin-services start
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8
Using Microsoft Active Directory
If you use Active Directory service software, configure it to control access to the network. Dell has modified the Active 
Directory database to support remote management authentication and authorization. Dell OpenManage IT Assistant and 
Dell OpenManage Server Administrator, as well as Integrated Dell Remote Access Controllers (iDRAC), Dell Remote 
Access Controllers (DRAC), can now interface with Active Directory. With this tool, you can add and control users and 
privileges from one central database.

Active Directory Schema Extensions
The Active Directory data exists in a distributed database of Attributes and Classes. An example of a Active Directory 
Class is the User class. Some example Attributes of the user class might be the user’s first name, last name, phone 
number, and so on. Define every Attribute or Class that is added to an existing Active Directory schema with a unique ID. 
To maintain unique IDs throughout the industry, Microsoft maintains a database of Active Directory Object Identifiers 
(OIDs).

The Active Directory schema defines the rules for what data can be included in the database. To extend the schema in 
Active Directory, install the latest Dell received unique OIDs, unique name extensions, and unique linked attribute IDs for 
the new attributes and classes in the directory service from the Dell Systems Management Tools and Documentation 
DVD.

Dell extension is: dell

Dell base OID is: 1.2.840.113556.1.8000.1280

Dell LinkID range is:12070 to 12079

Overview of the Active Directory Schema Extensions

Dell created classes, or groups of objects, that can be configured by the user to meet their unique needs. New classes 
in the schema include an Association, a Product, and a Privilege class. An association object links the user or group to a 
given set of privileges and to systems (Product Objects) in the network. This model gives an administrator control over 
the different combinations of user, privilege, and system or RAC device on the network, without adding complexity.

Active Directory Object Overview

For each of the systems that you want to integrate with Active Directory for authentication and authorization, there must 
be at least one Association Object and one Product Object. The Product Object represents the system. The Association 
Object links it with users and privileges. You can create as many Association Objects as you need.
Each Association Object can be linked to as many users, groups of users, and Product Objects as required. The users 
and Product Objects can be from any domain. However, each Association Object may only link to one Privilege Object. 
This behavior allows an administrator to control users and their rights on specific systems.

The Product Object links the system to Active Directory for authentication and authorization queries. When a system is 
added to the network, the administrator must configure the system and its product object with its Active Directory name 
so that users can perform authentication and authorization with Active Directory. The administrator must also add the 
system to at least one Association Object for users to authenticate.
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The following figure illustrates that the Association Object provide the connection that is needed for all of the 
authentication and authorization.

Figure 1. Typical Setup for Active Directory Objects

In addition, you can set up Active Directory objects in a single domain or in multiple domains. Setting up objects in a 
single domain does not vary, whether you are setting up RAC, Server Administrator, or IT Assistant objects. When 
multiple domains are involved, however, there are some differences.

The following figure shows the set up of the Active Directory objects in a single domain. In this scenario, you have two 
DRAC 4 cards (RAC1 and RAC2) and three existing Active Directory users (User1, User2, and User3). You want to give 
User1 and User2 administrator privilege on both DRAC 4 cards and give User3 login privilege on the RAC2 card.
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Figure 2. Setting Up RAC Active Directory Objects in a Single Domain

Setting Up Objects in a Single Domain

To set up the objects in a single domain scenario, perform the following tasks:

1. Create two Association Objects.
2. Create two RAC Product Objects, RAC1 and RAC2, to represent the two DRAC 4 cards.
3. Create two Privilege Objects, Priv1 and Priv2, in which Priv1 has all privileges (administrator) and Priv2 has login 

privileges.
4. Group User1 and User2 into Group1.
5. Add Group1 as Member in Association Object 1 (AO1), Priv1 as Privilege Object in AO1, and both RAC1 and RAC2 as 

RAC Products in AO1.
6. Add User3 as Member in Association Object 2 (AO2), Priv2 as Privilege Object in AO2, and RAC2 as RAC Product in 

AO2.

Related Links:

Adding Users and Privileges to Active Directory

Active Directory objects in multiple domains

The following figure shows the setup of the Active Directory objects in multiple domains for RAC. In this scenario, you 
have two DRAC 4 cards (RAC1 and RAC2) and three existing Active Directory users (User1, User2, and User3). User1 is in 
Domain1, but User2 and User3 are in Domain2. You want to give User1 and User2 Administrator privileges on both the 
RAC1 and RAC2 card and give User3 Login privilege on the RAC2 card.
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Figure 3. Setting Up RAC Active Directory Objects In Multiple Domains

Setting Up RAC Active Directory Objects in Multiple Domain

To set up the objects for this multiple domain scenario, perform the following tasks:

1. Ensure that the domain forest function is in Native mode.
2. Create two Association Objects, AO1 (of Universal scope) and AO2, in any domain.
3. Create two RAC Device Objects, RAC1 and RAC2, to represent the two remote systems.
4. Create two Privilege Objects, Priv1 and Priv2, in which Priv1 has all privileges (Administrator) and Priv2 has Login 

privileges.
5. Group User1 and User2 into Group1. The group scope of Group1 must be Universal.
6. Add Group1 as Member in Association Object 1 (AO1), Priv1 as Privilege Object in AO1, and both RAC1 and RAC2 as 

Products in AO1.
7. Add User3 as Member in Association Object 2 (AO2), Priv2 as Privilege Object in AO2, and RAC2 as a Product in 

AO2.

Setting up Server Administrator Active Directory Objects in Multiple Domains

For Server Administrator or IT Assistant, the users in a single Association can be in separate domains and need not be in 
a Universal group. The following is a very similar example to show how Server Administrator or IT Assistant systems in 
separate domains affect the setup of directory objects. Instead of RAC devices, you will have two systems running 
Server Administrator (Server Administrator Products sys1 and sys2). sys1 and sys2 are in different domains. You can use 
any existing Users or Groups that you have in Active Directory. The following figure shows how to set up the Server 
Administrator Active Directory objects for this example.
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Figure 4. Setting up Server Administrator Active Directory Objects In Multiple Domains

Setting Up Server Administrator Active Directory Objects for Multiple Domain

To set up the objects for this multiple domain scenario, perform the following tasks:

1. Ensure that the domain forest function is in Native mode.

2. Create two Association Objects, AO1 and AO2, in any domain. The figure shows the objects in Domain1.

3. Create two Server Administrator Products, sys1 and sys2, to represent the two systems. sys1 is in Domain1 and 
sys2 is in Domain2.

4. Create two Privilege Objects, Priv1 and Priv2, in which Priv1 has all privileges (Administrator) and Priv2 has Login 
privileges.

5. Group sys2 into Group1. The group scope of Group1 must be Universal.

6. Add User1 and User2 as Members in Association Object 1 (AO1), Priv1 as Privilege Objects in AO1, and both sys1 
and Group1 as Products in AO1.

7. Add User3 as a Member in Association Object 2 (AO2), Priv2 as a Privilege object in AO2, and Group1 as a Product 
in AO2.

NOTE: Neither of the Association objects needs to be of Universal scope.

Configuring Active Directory to Access the Systems

Before you can use Active Directory to access the systems, you must configure both the Active Directory software and 
the systems.

1. Extend the Active Directory schema.

2. Extend the Active Directory Users and Computers Snap-in.

3. Add system users and their privileges to Active Directory.

4. For RAC systems, enable SSL on each of the domain controllers.

5. Configure the system’s Active Directory properties using either the Web-based interface or the CLI.

Related Links:

• Extending the Active Directory Schema
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• Installing the Dell Extension to the Active Directory Users and Computers Snap-In

• Adding Users and Privileges to Active Directory

• Configuring the Systems or Devices

Configuring the Active Directory Product Name

To configure the Active Directory product name:

1. Locate the omsaoem.ini file in the installation directory.

2. Edit the file to add the line adproductname=text, where text is the name of the product object that you 
created in Active Directory. For example, the omsaoem.ini file contains the following syntax if the Active Directory 
product name is configured to omsaApp.
productname=Server Administrator
startmenu=Dell OpenManage Applications
autdbid=omsa
accessmask=3
adsupport=true
adproductname=omsaApp

3. Restart the Dell Systems Management Server Administrator (DSM SA) Connection Service after saving the 
omsaoem.ini file.

Extending the Active Directory Schema
The schema extensions for RAC, Server Administrator, and IT Assistant are available. Extend the schema for software or 
hardware that you are using. Apply each extension individually to receive the benefit of its software-specific settings. 
Extending the Active Directory schema adds schema classes and attributes, example privileges and association objects, 
and a Dell organizational unit to the schema.

NOTE: Before you extend the schema, you must have Schema Admin privileges on the Schema Master Flexible 
Single Master Operation (FSMO) Role Owner of the domain forest.

Extend the schema using two different methods. Use the Dell Schema Extender utility, or use the Lightweight Directory 
Interchange Format (LDIF) script file.

NOTE: The Dell organizational unit is not added if you use the LDIF script file.

The LDIF script files and the Dell Schema Extender utility are located in the following directories on the Dell Systems 
Management Tools and Documentation DVD:

• <DVD drive>drive>:\SYSMGMT\ManagementStation\support\OMActiveDirect ory_Tools\<installation type>\LDIF 
Files

• <DVD drive>:\SYSMGMT\ManagementStation\support\OMActiveDirect ory_ Tools\<installation type>\Schema 
Extender

The following table lists the folder names and <installation type>.

Table 12. Folder Names and Installation Types

Folder Name Installation Type

ITA7 IT Assistant version 8.9

OMSA Dell OpenManage Server Administrator

Remote_Management RAC 5, CMC, and iDRAC on xx0x Blade systems

Remote_Management_Advanced iDRAC on xx1x and xx2x systems
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Folder Name Installation Type

NOTE: Only iDRAC6 is supported on xx1x systems and 
iDRAC7 is supported on xx2X systems.

To use the LDIF files, see the instructions in the readme that is in the LDIF files directory. To use the Dell Schema 
Extender to extend the Active Directory Schema, perform the steps in Using the Dell Schema Extender.

Copy and run the Schema Extender or LDIF files from any location.

Using the Dell Schema Extender

To use the Dell Schema Extender perform the following tasks:

CAUTION: The Dell Schema Extender uses the SchemaExtenderOem.ini file. To ensure that the Dell Schema 
Extender utility functions properly, do not modify the name or the contents of this file.

1. Click Next on the Welcome screen.

2. Read the warning and click Next.

3. Select Use Current Log In Credentials or enter a user name and password with schema administrator rights.

4. Click Next to run the Dell Schema Extender.

5. Click Finish.
To verify the schema extension, use the Active Directory Schema Snap-in in the Microsoft Management Console 
(MMC) to verify the existence of the following classes and attributes. See the Microsoft documentation for more 
information on enabling and using the Active Directory Schema Snap-in.

For more information on class definitions for DRAC, see the Dell Remote Access Controller 4 User’s Guide and Dell 
Remote Access Controller 5 User’s Guide. For more information on class definitions for iDRAC, see the Integrated 
Dell Remote Access Controller User's Guide.

Table 13. Class Definitions for Classes Added to the Active Directory Schema

Class Name Assigned Object Identification 
Number (OID)

Class Type

dellAssociationObject 1.2.840.113556.1.8000.1280.1.1.1.2 Structural Class

dellPrivileges 1.2.840.113556.1.8000.1280.1.1.1.4 Structural Class

dellProduct 1.2.840.113556.1.8000.1280.1.1.1.5 Structural Class

dellOmsa2AuxClass 1.2.840.113556.1.8000.1280.1.2.1.1 Auxiliary Class

dellOmsaApplication 1.2.840.113556.1.8000.1280.1.2.1.2 Structural Class

dellIta7AuxClass 1.2.840.113556.1.8000.1280.1.3.1.1 Auxiliary Class

dellItaApplication 1.2.840.113556.1.8000.1280.1.3.1.2 Structural Class

Table 14. dellAssociationObject Class

OID 1.2.840.113556.1.8000.1280.1.1.1.2

Description This class represents the Dell Association Object. The 
Association Object provides the connection between 
the users and the devices or products.

Class Type Structural Class
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SuperClasses Group

Attributes dellProductMembers
dellPrivilegeMember

Table 15. dellPrivileges Class

OID 1.2.840.113556.1.8000.1280.1.1.1.4

Description This class is used as a container Class for the Dell 
Privileges (Authorization Rights).

Class Type Structural Class

SuperClasses User

Attributes dellRAC4Privileges
dellRAC3Privileges
dellOmsaAuxClass
dellItaAuxClass

Table 16. dellProduct Class

OID 1.2.840.113556.1.8000.1280.1.1.1.5

Description This is the main class from which all Dell products are 
derived.

Class Type Structural Class

SuperClasses Computer

Attributes dellAssociationMembers

Table 17. dellOmsa2AuxClass Class

OID 1.2.840.113556.1.8000.1280.1.2.1.1

Description This class is used to define the privileges (Authorization 
Rights) for Server Administrator.

Class Type Auxiliary Class

SuperClasses None

Attributes dellOmsaIsReadOnlyUser
dellOmsaIsReadWriteUser
dellOmsaIsAdminUser

Table 18. dellOmsaApplication Class

OID 1.2.840.113556.1.8000.1280.1.2.1.2

Description This class represents the Server Administrator 
application. Server Administrator must be configured as 
dellOmsaApplication in Active Directory. This 
configuration enables the Server Administrator 
application to send LDAP queries to Active Directory.
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Class Type Structural Class

SuperClasses dellProduct

Attributes dellAssociationMembers

Table 19. dellIta7AuxClass Class

OID 1.2.840.113556.1.8000.1280.1.3.1.1

Description This class is used to define the privileges (Authorization 
Rights) for IT Assistant.

Class Type Auxiliary Class

SuperClasses None

Attributes dellItaIsReadOnlyUser
dellItaIsReadWriteUser
dellItaIsAdminUser

Table 20. dellItaApplication Class

OID 1.2.840.113556.1.8000.1280.1.3.1.2

Description This class represents the IT Assistant application. 
Configure IT Assistant as dellItaApplication in Active 
Directory. This configuration enables IT Assistant to 
send LDAP queries to Active Directory.

Class Type Structural Class

SuperClasses dellProduct

Attributes dellAssociationMembers

Table 21. General Attributes Added to the Active Directory Schema

Attribute Name/Description Assigned OID/Syntax Object 
Identifier

Single Valued

dellPrivilegeMember
List of dellPrivilege Objects that 
belong to this Attribute.

1.2.840.113556.1.8000.1280.1.1.2.1
Distinguished Name (LDAPTYPE_DN 
1.3.6.1.4.1.1466.115.121.1.12)

FALSE

dellProductMembers
List of dellRacDevices Objects that 
belong to this role. This attribute is 
the forward link to the 
dellAssociationMembers backward 
link.
Link ID: 12070

1.2.840.113556.1.8000.1280.1.1.2.2
Distinguished Name (LDAPTYPE_DN 
1.3.6.1.4.1.1466.115.121.1.12)

FALSE

dellAssociationMembers
List of 
dellAssociationObjectMembers that 
belong to this Product. This attribute 
is the backward link to the 

1.2.840.113556.1.8000.1280.1.1.2.14
Distinguished Name (LDAPTYPE_DN 
1.3.6.1.4.1.1466.115.121.1.12)

FALSE
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Attribute Name/Description Assigned OID/Syntax Object 
Identifier

Single Valued

dellProductMembers Linked 
attribute.
Link ID: 12071

Table 22. Server Administrator-Specific Attributes Added to the Active Directory Schema

Attribute Name/Description Assigned OID/Syntax Object 
Identifier

Single Valued

dellOMSAIsReadOnlyUser
TRUE if the User has Read-Only 
rights in Server Administrator

1.2.840.113556.1.8000.1280.1.2.2.1
Boolean (LDAPTYPE_BOOLEAN 
1.3.6.1.4.1.1466.115.121.1.7)

TRUE

dellOMSAIsReadWriteUser
TRUE if the User has Read-Write 
rights in Server Administrator

1.2.840.113556.1.8000.1280.1.2.2.2
Boolean (LDAPTYPE_BOOLEAN 
1.3.6.1.4.1.1466.115.121.1.7)

TRUE

dellOMSAIsAdminUser
TRUE if the User has Administrator 
rights in Server Administrator

1.2.840.113556.1.8000.1280.1.2.2.3
Boolean (LDAPTYPE_BOOLEAN 
1.3.6.1.4.1.1466.115.121.1.7)

TRUE

Table 23. IT Assistant-Specific Attributes Added to the Active Directory Schema

Attribute Name/Description Assigned OID/Syntax Object 
Identifier

Single Valued

dellItaIsReadWriteUser
TRUE if the User has Read-Write 
rights in IT Assistant

1.2.840.113556.1.8000.1280.1.3.2.1
Boolean (LDAPTYPE_BOOLEAN 
1.3.6.1.4.1.1466.115.121.1.7)

TRUE

dellItaIsAdminUser
TRUE if the User has Administrator 
rights in IT Assistant

1.2.840.113556.1.8000.1280.1.3.2.2
Boolean (LDAPTYPE_BOOLEAN 
1.3.6.1.4.1.1466.115.121.1.7)

TRUE

dellItaIsReadOnlyUser
TRUE if the User has Read-Only 
rights in IT Assistant

1.2.840.113556.1.8000.1280.1.3.2.3
Boolean (LDAPTYPE_BOOLEAN 
1.3.6.1.4.1.1466.115.121.1.7)

TRUE

Active Directory Users and Computers Snap-In

When you extend the schema in Active Directory, extend the Active Directory Users and Computers snap-in so that the 
administrator can manage Products, Users and User Groups, Associations, and Privileges. Extend the snap-in once, 
even if you have added more than one schema extension. Install the snap-in on each system that you intend to use for 
managing these objects.

Installing the Dell Extension to the Active Directory Users and Computers Snap-In

When you are installing the systems management software using the Dell Systems Management Tools and 
Documentation DVD, you can install the Snap-in by selecting the Active Directory Snap-in option.

For 64-bit Windows operating systems, the Snap-in installer is located under <DVD drive>:\SYSMGMT
\ManagementStation\support\ OMActiveDirectory_SnapIn64.
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NOTE: Install the Administrator Pack on each management station that is managing the new Active Directory 
objects. If you do not install the Administrator Pack, you cannot view the new object in the container.

NOTE: For more information about the Active Directory Users and Computers snap-in, see the Microsoft 
documentation.

Related Links:

Opening the Active Directory Users and Computers Snap-In

Opening the Active Directory Users and Computers Snap-In

To open the Active Directory Users and Computers snap-in, perform the following steps:

1. If you are on the domain controller, click Start → Admin Tools → Active Directory Users and Computers . If you are 
not on the domain controller, you must have the appropriate Microsoft administrator pack installed on the local 
system. To install this administrator pack, click Start → Run, type MMC, and press <Enter>.

2. Click File in the Console 1 window.

3. Click Add/Remove Snap-in.

4. Click Add.

5. Select the Active Directory Users and Computers snap-in and click Add.

6. Click Close and click OK.

Adding Users and Privileges to Active Directory

The Dell-extended Active Directory Users and Computers snap-in allows you to add DRAC, Server Administrator, and IT 
Assistant users and privileges by creating RAC, Association, and Privilege objects. To add an object, perform the steps 
in the applicable subsection.

Creating a Product Object

To create a Product Object:

NOTE: Server Administrator and IT Assistant users must use Universal-type Product Groups to span domains with 
their product objects.

NOTE: When adding Universal-type Product Groups from separate domains, create an Association object with 
Universal scope. The default Association objects created by the Dell Schema Extender utility are domain Local 
Groups and do not work with Universal-type Product Groups from other domains.

1. In the Console Root (MMC) window, right-click a container.

2. Select New.

3. Select a RAC, Server Administrator, or IT Assistant object, depending on what you have installed.
The New Object window is displayed.

4. Type in a name for the new object. This name must match the Active Directory product name as discussed in 
Configuring Active Directory Using CLI on Systems Running Server Administrator.

5. Select the appropriate Product Object.

6. Click OK.

Creating a Privilege Object

Privilege Objects must be created in the same domain as the Association Object to which they are associated.
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1. In the Console Root (MMC) window, right-click a container.

2. Select New.

3. Select a RAC, Server Administrator, or IT Assistant object, depending on what you have installed.
The New Object window is displayed.

4. Type in a name for the new object.

5. Select the appropriate Privilege Object.

6. Click OK.

7. Right-click the privilege object that you created and select Properties.

8. Click the appropriate Privileges tab and select the privileges that you want the user to have.

Creating an Association Object

The Association Object is derived from a Group and must contain a group Type. The Association Scope specifies the 
Security Group Type for the Association Object. When you create an Association Object, choose the Association Scope 
that applies to the type of objects you intend to add. Selecting Universal, for example, means that Association Objects 
are only available when the Active Directory Domain is functioning in Native Mode.

1. In the Console Root (MMC) window, right-click a container.

2. Select New.

3. Select a RAC, Server Administrator, or IT Assistant object, depending on what you have installed.
The New Object window is displayed.

4. Type in a name for the new object.

5. Select Association Object.

6. Select the scope for the Association Object.

7. Click OK.

Adding Objects to an Association Object
By using the Association Object Properties window, you can associate users or user groups, privilege objects, systems, 
RAC devices, and system or device groups.

NOTE: RAC users must use Universal Groups to span domains with their users or RAC objects.

You can add groups of Users and Products. You can create Dell-related groups in the same way that you created other 
groups.

To add Users or User Groups

1. Right-click the Association Object and select Properties.

2. Select the Users tab and click Add.

3. Type the User or User Group name or browse to select and click OK.
Click the Privilege Object tab to add the privilege object to the association that defines the user’s or user group’s 
privileges when authenticating to a system.

NOTE: Add only one Privilege Object to an Association Object.

To add a privilege

1. Select the Privileges Object tab and click Add.

2. Type the Privilege Object name or browse and click OK.
Click the Products tab to add one or more systems or devices to the association. The associated objects specify the 
products connected to the network that are available for the defined users or user groups.
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NOTE: Add multiple systems or RAC devices to an Association Object.

To add Products

1. Select the Products tab and click Add.
2. Type the system, device, or group name and click OK.
3. In the Properties window, click Apply and then OK.

Configuring the Systems or Devices
For instructions on configuring the Server Administrator or IT Assistant systems using CLI commands, see Configuring 
Active Directory Using CLI on Systems Running Server Administrator. For DRAC users, see the Dell Remote Access 
Controller 4 User’s Guide or Dell Remote Access Controller 5 User’s Guide. For iDRAC users, see the Integrated Dell 
Remote Access Controller User's Guide.

NOTE: The systems on which Server Administrator and/or IT Assistant are installed must be a part of the Active 
Directory domain and should also have computer accounts on the domain.

Configuring Active Directory Using CLI on Systems Running Server Administrator
You can use the omconfig preferences dirservice command to configure the Active Directory service. The 
productoem.ini file is modified to reflect these changes. If the adproductname is not present in the productoem.ini file, a 
default name is assigned.

The default value is system name-software-product name, where system name is the name of the system running Server 
Administrator, and softwareproduct name refers to the name of the software product defined in omprv32.ini (that is, 
computerName-omsa).

NOTE: This command is applicable only on Windows.

NOTE: Restart the Server Administrator service after you have configured Active Directory.

The following table shows the valid parameters for the command.
Table 24. Active Directory Service Configuration Parameters

name=value pair Description

prodname=<text> Specifies the software product to which you want to apply 
the Active Directory configuration changes. Prodname 
refers to the name of the product defined in omprv32.ini. 
For Server Administrator, it is omsa.

enable=<true | false> true: Enables Active Directory service authentication 
support.
false: Disables Active Directory service authentication 
support.

adprodname=<text> Specifies the name of the product as defined in the Active 
Directory service. This name links the product with the 
Active Directory privilege data for user authentication.
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9
Frequently Asked Questions
How do I install Dell OpenManage Server Administrator with only 
the CLI features?
By choosing not to install the Server Administrator Web Server, you get CLI features only.

What ports do Dell OpenManage applications use?
The default port used by Server Administrator is 1311. The default ports used by Dell OpenManage IT Assistant are 2607 
(for the connection service) and 2606 (for the network monitoring service). These ports are configurable. For port 
information of a particular component, see the User Guide of that respective component.

When I run virtual media on the DRAC controller over a Wide Area 
Network (WAN) with low bandwidth and latency, launching Dell 
OpenManage Install directly on the virtual media failed, what do I 
do?
Copy the web install package (available on support.dell.com) to the local system and then launch Dell OpenManage 
Install.

Do I need to uninstall the Adaptec Fast Console application 
installed on the system before installing the Server Administrator 
Storage Management Service?
Yes, if you already have Adaptec Fast Console installed on the system, you must uninstall this application before 
installing the Server Administrator Storage Management Service.

Microsoft Windows

How do I fix a faulty installation of Server Administrator?

You can fix a faulty installation by forcing a reinstall and then performing an uninstall of Server Administrator. To force a 
reinstall:

1. Find out the version of Server Administrator that was previously installed.

2. Download the installation package for that version from support.dell.com.

3. Locate SysMgmt.msi from the SYSMGMT\srvadmin\windows\SystemsManagement directory and enter the 
following command at the command prompt to force a reinstall.
msiexec /i SysMgmt.msi REINSTALL=ALL REINSTALLMODE=vomus
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4. Select Custom Setup and choose all the features that were originally installed. If you are not sure which features 
were installed, select all of them and perform the installation.

NOTE: If you installed Server Administrator in a non-default directory, make sure to change it in Custom Setup as 
well.

Once the application is installed, you can uninstall it from Add/Remove Programs.

What do I do when the creation of WinRM listener fails with the following error message?

The CertificateThumbprint property must be empty when the SSL configuration 
will be shared with another service

This error occurs when the Internet Information Server (IIS) is already installed and configured for HTTPS 
communication. Details about coexistence of IIS and WinRM is available at technet.microsoft.com/en-us/library/
cc782312.aspx.

In this case, use the following command to create a HTTPS Listener with the CertificateThumbprint empty:
winrm create winrm/config/Listener?Address=*+Transport=HTTPS 
@{Hostname="<host_name>";CertificateThumbprint=""}

What are the firewall-related configuration that needs to be done for WinRM?

With firewall turned ON, WinRM must be added to the firewall exclusion list to allow TCP port 443 for HTTPS traffic.

When launching the Dell OpenManage Install, an error message may display, stating a 
failure to load a specific library, a denial of access, or an initialization error. An example of 
installation failure during Dell OpenManage Install is "failed to load OMIL32.DLL." What do 
I do?

This is most likely due to insufficient Component Object Model (COM) permissions on the system. To remedy this 
situation, see the article support.installshield.com/kb/view.asp?articleid=Q104986

The Dell OpenManage Install may also fail if a previous installation of Dell OpenManage systems management software 
or some other software product was unsuccessful. Delete the following temporary windows installer registry, if present:
HKLM\Software\Microsoft\Windows\CurrentVersion\Installer\InProgress

I get a misleading warning or error message during Dell OpenManage installation.

If you have insufficient disk space on the Windows system drive, you may encounter misleading warning or error 
messages when you run Dell OpenManage Install. Additionally, windows installer requires space to temporarily extract 
the installer package to the %TEMP% folder. Ensure that you have sufficient disk space (100 MB or more) on the system 
drive prior to running Dell OpenManage Install.

I am getting the following error message while launching Dell OpenManage Install:

An older version of Server Administrator software is detected on this system. 
You must uninstall all previous versions of Server Administrator applications 
before installing this version

If you see this error when trying to launch Dell OpenManage Install, it is recommended that you run the OMClean.exe 
program, under the SYSMGMT\srvadmin\support\OMClean directory, to remove an older version of Server Administrator 
on the system.

78



Do I need to uninstall previous versions of Server Administrator before installing Citrix 
Metaframe?

Yes. Uninstall previous versions of Server Administrator before installing Citrix Metaframe (all versions). As errors may 
exist in the registry after the Citrix Metaframe installation, you must reinstall Server Administrator.

When I run Dell OpenManage Install, I see unreadable characters on the Prerequisite 
check information screen.

When you run Dell OpenManage Install in English, German, French, or Spanish and get unreadable characters on the 
Prerequisite Check Information screen, ensure that the browser encoding has the default character set. Resetting the 
browser encoding to use the default character set resolves the problem.

I have installed Server Administrator and Dell Online Diagnostics in the same directory 
and Dell Online Diagnostics fails to work, what do I do?

If you have installed Server Administrator and Online Diagnostics in the same directory, Online Diagnostics may fail to 
work. On uninstalling Server Administrator, you may also lose all Online Diagnostics files. To avoid this problem, install 
Server Administrator and Online Diagnostics in different directories. In general it is recommended not to install more 
than one application in the same directory.

I have installed Server Administrator using remote Server Administrator deploy on 
Windows Server 2008, I do not see Server Administrator icon on the desktop?

On an initial Server Administrator install using remote Server Administrator deploy (OMSA push) on a server running 
Windows Server 2008, the Server Administrator icon is not visible until the desktop is refreshed manually by pressing the 
<F5> key.

I see a warning message while uninstalling Server Administrator on Windows Server 2008 
as the installer tries to remove the shortcut?

While uninstalling Server Administrator on Windows Server 2008, you might see a warning message as the installer tries 
to remove the shortcut. Click OK to continue the uninstallation.

Where can I find the MSI log files? 

By default, the MSI log files are stored in the path defined by the %TEMP% environment variable.

I downloaded the Server Administrator files for Windows from the Dell Support website 
and copied it to my own media. When I tried to launch the SysMgmt.msi file, it failed. What 
is wrong?

MSI requires all installers to specify the MEDIAPACKAGEPATH property if the MSI file does not reside on the root of the 
DVD.

This property is set to SYSMGMT\srvadmin\windows\SystemsManagement for the managed system software MSI 
package. If you want to make the own DVD you must ensure that the DVD layout stays the same. The SysMgmt.msi file 
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must be located in the SYSMGMT \srvadmin\windows\SystemsManagement. For more detailed information, go to 
msdn.microsoft.com and search for
MEDIAPACKAGEPATH Property

Does Dell OpenManage Install support Windows Advertised installation?

No. Dell OpenManage Install does not support Windows Advertised installation - the process of automatically 
distributing a program to client computers for installation, through the Windows group policies.

How do I check the disk space availability during custom installation?

In the Custom Setup screen, you must click an active feature to view the hard drive space availability or to change the 
installation directory. For example, if Feature A is selected for installation (active) and Feature B is not active, the 
Change and Space buttons are disabled if you click Feature B. Click Feature A to view the space availability or to change 
the installation directory.

What do I do when I see the current version is already installed message is displayed?

If you upgrade from version X to version Y using MSP and then try to use the version Y DVD (full install), the prerequisite 
checker on the version Y DVD informs you that the current version is already installed. If you proceed, the installation 
does not run in Maintenance mode and you do not get the option to Modify, Repair, or Remove. Proceeding with the 
installation removes the MSP and creates a cache of the MSI file present in the version Y package. When you run it a 
second time, the installer runs in Maintenance mode.

What is the best way to use the prerequisite checker information?

The prerequisite checker is available for Windows. See the readme file at SYSMGMT\srvadmin\windows
\PreReqChecker\readme.txt on the Dell Systems Management Tools and Documentation DVD, for detailed information 
about using the prerequisite checker.

In the Prerequisite Checker screen, I get the following message. What can I do to resolve 
this problem?

An error occurred while attempting to execute a Visual Basic Script. Please 
confirm that Visual Basic files are installed correctly.

This error occurs when the prerequisite checker calls the Dell OpenManage script, vbstest.vbs (a Visual Basic script), to 
verify the installation environment, and the script fails. The possible causes are:

• Incorrect Internet Explorer Security Settings.

Ensure that Tools → Internet Options → Security → Custom level → Scripting → Active scripting is set to 
Enable.
Ensure that Tools → Internet Options → Security → Custom level → Scripting → Scripting of Java applets 
is set to Enable.

• Windows Scripting Host (WSH) has disabled the running of VBS scripts. WSH is installed during operating 
system installation, by default. On Windows 2003, WSH can be configured to prevent the running of scripts with 
a .VBS extension.

a. Right-click My Computer on the desktop and click Open → Tools → Folder Options → File Types .

b. Look for the VBS file extension and ensure that File Types is set to VBScript Script File. 
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c. If not, click Change and choose Microsoft Windows Based Script Host as the application that gets invoked 
to run the script.

• WSH is the wrong version, corrupted, or not installed. WSH is installed during operating system installation, by 
default. Download WSH from msdn.microsoft.com.

Is the time shown during installation or uninstallation by Windows Installer Services 
accurate?

No. During installation or uninstallation, the Windows Installer Service may display the time remaining for the current 
task to complete. This is only an approximation by the Windows Installer Engine based on varying factors.

Can I launch my installation without running the prerequisite checker? How do I do that?

Yes, you can. For example, you can run the MSI of the managed system software, directly from SYSMGMT\srvadmin
\Windows\SystemsManagement. In general, it is not a good idea to bypass the prerequisite checker as there could be 
important information that you would not know otherwise.

How do I know what version of systems management software is installed on the system?

Navigate to the Windows Control Panel and double-click Add/Remove Programs and select Dell OpenManage Server 
Administrator. Select the link for support information.

Do I need to reboot the system after upgrading the Dell OpenManage?

Upgrade may require a reboot if the files to be upgraded are in use. This is a typical Windows installer behavior. It is 
recommended that you reboot the system when prompted.

Where can I see the Server Administrator features that are currently installed on my 
system?

Navigate to the Windows Control Panel and double-click Add/Remove Programs to view the Server Administrator 
features that are currently installed.

What are the names of all the Dell OpenManage features under Windows?

The following table lists the names of all Dell OpenManage features and their corresponding names in Windows.

Table 25. Dell OpenManage Features — Windows

Feature Name in WIndows

Managed System Services

Server Administrator Instrumentation Service DSM SA Data Manager
DSM SA Event Manager

Server Administrator DSM SA Connection Service
DSM SA Shared Services

Server Administrator Storage Management Service Mr2kserv
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Feature Name in WIndows

Remote Access Controller Console (DRAC 4) Remote Access Controller 4 (DRAC 4)

Red Hat Enterprise Linux or SUSE Linux Enterprise Server

After installing Server Administrator, I cannot log in.

Log out and then log in again to access the Server Administrator Command Line Interface (CLI).

I see the following message when I try to install Server Administrator on a guest Linux 
operating system.

./srvadmin-install.sh: line 2295 : [: ==: unary operator expected.

When installing Dell OpenManage components on a guest Linux operating system, the warning message may be 
displayed. However, the installation continues and completes without any loss of functionality.

I manually installed my Red Hat Enterprise Linux 4 64-bit operating system and can see 
RPM dependencies while installing Server Administrator. Where can I find these 
dependent RPM files?

For Red Hat Enterprise Linux, the dependent RPM files are on the Red Hat Enterprise Linux installation media. All other 
RPMs are available in the /SYSMGMT/srvadmin/linux/RPMS/supportRPMS\opensource-components directory. To install 
or update all the dependent RPM files execute the following command:
rpm –ivh /SYSMGMT/srvadmin/linux/RPMS/ supportRPMS/opensource-components

You can then continue with the Server Administrator installation.

I have performed a non-default install of the Linux operating system using the Linux 
operating system media, I see missing RPM file dependencies while installing Server 
Administrator?

Server Administrator is a 32-bit application. When installed on a system running a 64-bit version of Red Hat Enterprise 
Linux operating system, the Server Administrator remains a 32-bit application, while the device drivers installed by 
Server Administrator are 64-bit. If you attempt to install Server Administrator on Red Hat Enterprise Linux (versions 5 and 
version 6) for Intel EM64T, ensure that you install the applicable 32-bit versions of the missing RPM file dependencies. 
The 32-bit RPM versions always have i386 in the file name extension. You may also experience failed shared object files 
(files with so in the file name extension) dependencies. In this case, you can determine which RPM is needed to install 
the shared object, by using the RPM --whatprovides switch. For example: rpm -q --whatprovides 
libpam.so.0
An RPM name such as pam-0.75-64 could be returned, so obtain and install the pam-0.75-64.i386.rpm. When Server 
Administrator is installed on a system running a 64-bit version of Linux operating system, ensure that the compat-libstdc
++-<version>.i386.rpm RPM package is installed. You need to resolve the dependencies manually by installing the 
missing RPM files from the Linux operating system media.

NOTE: If you are using later versions of supported Linux operating systems and the RPM files available in the 
directory SYSMGMT/srvadmin/linux/RPMS/supportRPMS on the DVD are incompatible, use the latest RPMs from 
the operating system media.
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Where can I find the source packages for Open Source RPMs?

Source packages for Open Source RPMs are available on an orderable DVD image.

What do I do when management station RAC utility installation fails due to missing RPM 
file?

During the installation of the management station RAC utility (mgmtst-racadm RPM under /SYSMGMT/
ManagementStation/linux/rac directory on the Dell Systems Management Tools and Documentation DVD), the 
installation may fail due to missing RPM file dependencies on libstdc++.so libraries. Install the compat-libstdc++ RPM 
provided in the same directory to resolve the dependency and retry the installation.

When using the rpm -e 'rpm -qa | grep srvadmin' command to remove Dell OpenManage 
systems management software, some RPM utility versions may schedule an uninstallation 
in an incorrect order, which results in users encountering misleading warning or error 
messages. What is the solution?

The solution is to use the Dell OpenManage uninstall script srvadmin-uninstall.sh, provided on the DVD.

What do I do when I am asked to authenticate using the root user account?

Dell Systems Build and Update Utility adds a script to the root user's .bash_profile file that prompts for the installation of 
Dell OpenManage systems management software. This script may interfere with remote client applications that 
authenticate using the root user account on the system, but do not have a means to handle user prompts. To remedy this 
limitation, edit the .bash_profile file and comment the line [ ${SHLVL}....
During uninstallation, error: %preun(srvadmin-NAME-X.Y.Z-N.i386) scriptlet failed, exit 
status 1 error message is displayed.

There may be problems uninstalling Server Administrator after an unsuccessful upgrade during a manual RPM upgrade. 
The following error message is displayed:
error: %preun(srvadmin-NAME-X.Y.Z-N.i386) scriptlet failed, exit status 1

In this case, NAME is a feature name, for example omacore. X.Y.Z-N is the version and build number of the 
feature. Some possible solutions to rectify this problem:

1. Attempt to uninstall again. For example, use the following command:
 rpm -e srvadmin-NAME-X.Y.Z-N.i386

2. Delete the upgrade.relocation=bad line if present in the /etc/omreg.cfg file and attempt to uninstall again.

Why am I getting a warning concerning the RPM package key during installation?

The RPM files are signed with a digital signature. To avoid this warning, you should mount the media or package, and 
import the key using a command such as the following:
 rpm --import /mnt/dvdrom/SYSMGMT/srvadmin/linux/RPM-GPG-KEY
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What are the names of all the Dell OpenManage features under Red Hat Enterprise Linux 
or SUSE Linux Enterprise Server?

The following table lists the names of all Dell OpenManage features and their corresponding init script names under Red 
Hat Enterprise Linux and SUSE Linux Enterprise Server operating systems.

Table 26. Dell OpenManage Features — VMware ESX, Red Hat Enterprise Linux, and SUSE Linux Enterprise Server

Feature Name in VMware ESX, Red Hat Enterprise Linux, and 
SUSE Linux Enterprise Server

Managed System Services Feature Feature init Script Name

DSM SA Device Drivers
DSM SA Data Engine Service

instsvcdrv
dataeng

DSM SA Shared Service
DSM SA Connection Service

dsm_om_shrsvc
dsm_om_connsvc

DSM SM LSI Manager mptctl

Integrated Dell Remote Access Controller (iDRAC) None

Remote Access Controller (DRAC 4) racsvc

Remote Access Controller (DRAC 5) None

What do the directories under srvadmin/linux/custom/<operating system> contain?

The following table lists the names of the directories in the SYSMGMT/srvadmin/linux/custom/<operating system> 
directory.

Table 27. Names of the Directories Under the srvadmin/linux/custom/<operating system> directory

Name of RPM Description Other Server Administrator RPMs 
required

Server-Instrumentation — This is the core code for Server Administrator. It provides motherboard alerts and contains 
the CLI that allows to monitor and control Server Administrator, for example, omconfig, omdiag, and omreport. 
All peripheral packages, except the standalone DRAC support, require all or most of the RPMs in this directory to be 
installed.

NOTE: You may need to install IPMI drivers for proper functionality.

srvadmin-cm Server Administrator Inventory 
Collector — Systems management 
change management inventory 
collector.

srvadmin-omilcore, srvadmin-deng, 
and srvadmin-omacore

srvadmin-deng Server Administrator Data Engine — 
Systems management provides a data 
management framework for systems 
management software.

srvadmin-omilcore

srvadmin-hapi Server Administrator Hardware 
Application Programming Interface — 
This systems management package 

srvadmin-omilcore
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Name of RPM Description Other Server Administrator RPMs 
required

provides the device drivers and 
libraries needed by systems 
management software to access 
information about the hardware on 
supported systems.

srvadmin-isvc Server Administrator Instrumentation 
Service — Server Administrator 
provides a suite of systems 
management information for keeping 
supported systems on the network 
healthy. Server Administrator 
Instrumentation Service provides fault 
management information, prefailure 
information, and asset and inventory 
information to management 
applications. The Instrumentation 
Service monitors the health of the 
system and provides rapid access to 
detailed fault and performance 
information about the hardware on 
supported systems. The 
Instrumentation Service requires 
installation of systems management 
device drivers.

srvadmin-omilcore, srvadmin-deng, 
and srvadmin-hapi

srvadmin-omacore Server Administrator — Systems 
management managed mode core 
and CLI.

srvadmin-omilcore and srvadmin-
deng

srvadmin-omhip Server Administrator Instrumentation 
Service Integration Layer — Provides 
Instrumentation CLI.

srvadmin-omilcore, srvadmin-deng, 
srvadmin-hapi, srvadmin-isvc, and 
srvadmin-omacore

srvadmin-omilcore Server Administrator Install Core — 
This is the core install package that 
provides the tools necessary for the 
rest of the Systems management 
install packages. All Server 
Administrator RPMs require this RPM.

srvadmin-syscheck Package that checks the level of Dell 
OpenManage support.

srvadmin-omilcore

add-iDRAC — Software for remote management of third generation Remote Access Controllers. For example, iDRAC.

srvadmin-idrac-components Integrated Dell Remote Access Card 
Data Populator Remote Access 
Controller components.

srvadmin-omilcore, srvadmin-deng, 
srvadmin-hapi, and srvadmin-racser

srvadmin-idracadm iDRAC Command Interface — The 
command line user interface to the 

srvadmin-omilcore
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Name of RPM Description Other Server Administrator RPMs 
required

Integrated Dell Remote Access 
Controller.

srvadmin-idracdrsc iDRAC Integration Layer — Integrated 
Dell Remote Access CLI and Web 
Plug-in to Server Administrator.

srvadmin-omilcore, srvadmin-deng, 
srvadmin-rac4 components, and 
srvadmin-omacore

add-RAC4 — Software for remote management of fourth generation Remote Access Controllers. For example, DRAC 4.

srvadmin-rac4-components Remote Access Card Data Populator 
— Remote Access Controller 
components.

srvadmin-omilcore, srvadmin-deng, 
srvadmin-hapi, and srvadmin-racsvc

srvadmin-racadm4 RAC Command Interface — The 
command line user interface to the 
Remote Access Controller (RAC).

srvadmin-omilcore

srvadmin-racdrsc4 DRAC 4 Integration Layer — Remote 
Access CLI and Web Plugin to Server 
Administrator.

srvadmin-omilcore, srvadmin-deng, 
srvadmin-rac4 components, and 
srvadmin-omacore

srvadmin-racsvc Remote Access Card Managed Node 
— Remote Access Controller (RAC) 
services supporting the central 
administration of server clusters and 
the remote administration of 
distributed resources.

srvadmin-omilcore

add-RAC5 — Software for remote management of fifth generation Remote Access Controllers. For example, DRAC 5.

srvadmin-rac5-components Remote Access Card Data Populator, 
DRAC 5 and Remote Access 
Controller components, DRAC 5.

srvadmin-omilcore, srvadmin-deng, 
and srvadmin-hapi

srvadmin-racadm5 RAC Command Interface — The 
command line user interface to the 
Remote Access Controller (RAC).

srvadmin-omilcore and srvadmin-hapi

srvadmin-racdrsc5 DRAC 5 Integration Layer — Remote 
Access CLI and Web Plug-in to Server 
Administrator.

srvadmin-omilcore, srvadmin-deng, 
srvadmin-omacore, and srvadmin-
rac5 components

add-StorageManagement — Storage Management RAID configuration utility and storage alert software.

srvadmin-storage Storage Management — Provides 
Systems Management Storage 
Services.

srvadmin-omilcore, srvadmin-deng, 
srvadmin-omacore, and srvadmin-odf

SA-WebServer — Provides web access to manage the server.

srvadmin-hapi Server Administrator Hardware 
Application Programming Interface — 
This systems management package 
provides the device drivers and 
libraries needed by systems 

srvadmin-omilcore
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Name of RPM Description Other Server Administrator RPMs 
required

management software to access 
information about the hardware on 
supported systems.

srvadmin-tomcat Secure Port Server — Systems 
Management Managed Node Web 
Server package.

srvadmin-omilcore, srvadmin-deng, 
srvadmin-omacore, and srvadmin-jre

srvadmin-jre Server Administrator Sun Java 
Runtime Environment — Systems 
management managed node Java 
runtime.

srvadmin-omilcore, srvadmin-deng, 
and srvadmin-omacore

srvadmin-omauth Provides the authentication files. srvadmin-omilcore

srvadmin-omcommon Provides the common framework 
required by Server Administrator.

srvdamin-omilcore

srvadmin-omilcore Server Administrator Web Server 
Install Core — This is the core install 
package. All Server Administrator 
Web Server RPMs require this RPM.

srvadmin-wsmanclient Operating system specific WSMan 
client package.

srvadmin-omcommon and srvadmin-
omauth

Remote-Enablement — Manage and monitor the current system using some other remote system.

srvadmin-cm Server Administrator Inventory 
Collector — Systems management 
change management inventory 
collector.

srvadmin-omilcore, srvadmin-deng, 
and srvadmin-omacore

srvadmin-deng Server Administrator Data Engine — 
Systems management provides a data 
management framework for systems 
management software.

srvadmin-omilcore

srvadmin-hapi Server Administrator Hardware 
Application Programming Interface — 
This systems management package 
provides the device drivers and 
libraries needed by systems 
management software to access 
information about the hardware on 
supported systems.

srvadmin-omilcore

srvadmin-isvc Server Administrator Instrumentation 
Service — Server Administrator 
provides a suite of systems 
management information for keeping 
supported systems on the network 
healthy. Server Administrator 

srvadmin-omilcore, srvadmin-deng, 
and srvadmin-hapi
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Name of RPM Description Other Server Administrator RPMs 
required

Instrumentation Service provides fault 
management information, prefailure 
information, and asset and inventory 
information to management 
applications. The Instrumentation 
Service monitors the health of the 
system and provides rapid access to 
detailed fault and performance 
information about the hardware on 
supported systems. The 
Instrumentation Service requires 
installation of systems management 
device drivers.

srvadmin-omacore Server Administrator — Systems 
management managed mode core 
and CLI.

srvadmin-omilcore and srvadmin-
deng

srvadmin-omcommon Provides Common Framework 
required by Server Administrator.

srvadmin-omilcore

srvadmin-omhip Server Administrator Instrumentation 
Service Integration Layer — Provides 
Instrumentation CLI.

srvadmin-omilcore, srvadmin-deng, 
srvadmin-hapi, srvadmin-isvc, and 
srvadmin-omacore

srvadmin-omilcore Server Administrator Install Core — 
This is the core install package that 
provides the tools necessary for the 
rest of the Systems management 
install packages. All Server 
Administrator RPMs require this RPM.

srvadmin-ssa Enables management of the system 
from a remote system on which 
Server Administrator Web Server is 
installed, using WS-Man interfaces.

srvadmin-omacore, srvadmin-omhip, 
and srvadmin-isvc.

srvadmin-syscheck Package that checks the level of Dell 
OpenManage support.

srvadmin-omilcore

What are the additional components that can be installed on a system that already has 
Server Administrator installed?

There are a few additional components that can be installed on a system that already has Server Administrator installed. 
For example, you can install Online Diagnostics on a system that has previously been installed with managed system 
software. On such a system, while uninstalling Server Administrator, only those RPM packages that are not required by 
any of the newly installed components are uninstalled. In the above example, Online Diagnostics requires packages 
such as - srvadmin-omilcore-X.Y.Z-N and srvadmin-hapi-X.Y.Z-N. These packages are not uninstalled during an 
uninstallation of Server Administrator.

88



In this case, if you try to install Server Administrator later by running the sh srvadmin-install.sh command, the 
following message is displayed:
Server Administrator version X.Y.Z is currently installed.

Installed components are:

• srvadmin-omilcore-X.Y.Z-N

• srvadmin-hapi-X.Y.Z-N

Do you want to upgrade Server Administrator to X.Y.Z? Press (y for yes| <Enter> to exit):

On pressing <y>, only those Server Administrator packages (in the above example), srvadmin-omilcore-X.Y.Z-N and 
srvadmin-hapi-X.Y.Z-N residing on the system are upgraded.

If you have to install other Dell OpenManage components as well, the sh srvadmin-install.sh command has to 
be run once again.

What happens if I install the RPM package on an unsupported system or on an 
unsupported operating system?

If you try to install the RPM packages on an unsupported system or an unsupported operating system, you may see 
unpredictable behavior during the install, uninstall, or during use of the RPM package. Most of the RPM packages have 
been written and tested for Dell PowerEdge systems and the Linux versions listed in the readme.

What daemons run on Red Hat Enterprise Linux and SUSE Linux Enterprise Server 
operating systems after Server Administrator is started?

The daemons that run on Red Hat Enterprise Linux and SUSE Linux Enterprise Server operating systems depend on what 
is installed and what is enabled to run. The following table displays the daemons that typically run for a full install:

Table 28. Daemons that Run on Red Hat Enterprise Linux and SUSE Linux Enterprise Server Once Server Administrator is 
Started

Daemon Name Name in Red Hat Enterprise Linux and SUSE Linux 
Enterprise Server

For RPMs in the srvadmin-base directory

dsm_sa_datamgr32d DSM SA Data Manager — Server Administrator data 
manager daemon started by DSM SA Data Engine service.

dsm_sa_eventmgr32d DSM SA Event Manager — Server Administrator event 
and logging daemon started by DSM SA Data Engine 
service.

dsm_sa_snmp32d DSM SA SNMP daemon — Server Administrator SNMP 
daemon started by DSM SA Data Engine service.

dsm_om_shrsvc32d DSM SA Shared Services — Server Administrator core 
daemon.

For RPMs in the SA-WebServer directory

dsm_om_connsvc32d DSM SA Connection Services — Server Administrator 
Web server daemon.

For systems that support DRAC 4: add-RAC4
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Daemon Name Name in Red Hat Enterprise Linux and SUSE Linux 
Enterprise Server

racsvc DRAC 4 Administrator daemon.

What kernel modules are loaded when Server Administrator is started?

This is dependent on the type of systems instrumentation. The following table displays the kernel modules loaded when 
Server Administrator is started.

Table 29. Kernel Modules Loaded When Server Administrator Services are Started

Driver Name Description

For a system with IPMI

dell_rbu Dell BIOS Update Driver

ipmi_devintf IPMI device driver

ipmi_msghandler IPMI device driver

ipmi_si IPMI device driver — For systems running Red Hat 
Enterprise Linux or SUSE Linux Enterprise Server

For a TVM system

dcdbas Dell Systems Management Base Driver

dell_rbu Dell BIOS Update Driver

For an ESM system

dcdbas Dell Systems Management Base Driver

dell_rbu Dell BIOS Update Driver

For support of Server Administrator Storage Systems

mptctl Device driver for LSI RAID
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10
Dell OpenManage Linux Installer Packages
This section lists the Dell OpenManage Linux installer packages.

Table 30. Meta RPMs

RPM Description Dependent 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

srvadmin-all Meta package for 
installing all Server 
Administrator 
features

srvadmin-base, 
srvadmin-idrac, 
srvadmin-rac4, 
srvadmin-rac5, 
srvadmin-
standardAgent, 
srvadmin-
storageservices, 
srvadmin-
webserver

Complete Server 
Administrator 
features

Y Y Y Y

srvadmin-base Meta package for 
installing the 
Server Agent

srvadmin-cm, 
srvadmin-omacore, 
srvadmin-
smcommon

Server 
Instrumentation, 
SNMP monitoring, 
and Server 
Administrator CLI

Y Y Y Y

srvadmin-
standardAgent

Meta package for 
installing the 
Standard Server 
Agent

srvadmin-cm, 
srvadmin-
itunnelprovider, 
srvadmin-
smcommon

Enabling remote 
management using 
Server 
Administrator Web 
Server

Y Y Y Y

srvadmin-
webserver

Meta package for 
installing the 
Server 
Administrator Web 
Server feature

srvadmin-
smcommon, 
srvadmin-smweb, 
srvadmin-tomcat

Server 
Administrator Web 
Server for local and 
remote node 
management

Y Y Y Y

srvadmin-
storageservices

Meta package for 
installing the 
Server 
Administrator 
Storage Services 
feature

srvadmin-cm, 
srvadmin-megalib, 
srvadmin-
smcommon, 
srvadmin-storage, 
srvadmin-storelib, 
srvadmin-sysfsutils

Storage 
Management using 
Server 
Administrator 
GUI/CLI

Y Y Y Y

srvadmin-rac4 Meta RPM for 
RAC4 components

srvadmin-omilcore, 
srvadmin-rac-

RAC 4 management 
using Server 

Y Y Y Y
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RPM Description Dependent 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

components, 
srvadmin-rac4-
populator, 
srvadmin-racadm4, 
srvadmin-racdrsc, 
srvadmin-racsvc

Administrator GUI/
CLI, RAC4 tools

srvadmin-rac5 Meta RPM for 
RAC5 components

srvadmin-isvc, 
srvadmin-omilcore, 
srvadmin-rac-
components, 
srvadmin-racadm4, 
srvadmin-racadm5, 
srvadmin-racdrsc

RAC 5 management 
using Server 
Administrator GUI/
CLI, RAC5 tools

Y Y Y Y

srvadmin-idrac Meta RPM for 
iDRAC components

srvadmin-
argtable2, 
srvadmin-deng, 
srvadmin-idrac-
ivmcli, srvadmin-
idrac-vmcli, 
srvadmin-
idracadm, 
srvadmin-isvc, 
srvadmin-
omcommon, 
srvadmin-omilcore, 
srvadmin-rac-
components, 
srvadmin-racadm4, 
srvadmin-racdrsc

iDRAC 
management using 
Server 
Administrator GUI/
CLI, iDRAC tools

Y Y Y Y

Table 31. Server Instrumentation and SNMP monitoring

RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

srvadmin-
omilcore

Core Install 
package that 
provides 
tools for the 
systems 
management 
install 
packages

pciutils,smbi
os-utils-bin

Installing 
and 
functioning 
of Server 
Administrato
r

Y Y Y Y

srvadmin-
deng

Data Engine 
stores and 
manages 

srvadmin-
omilcore

Server 
Instrumentati
on and 

Y Y Y Y
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RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

objects for 
systems 
management

SNMP 
monitoring

srvadmin-
hapi

Provides 
low-level 
hardware 
interface for 
systems 
management

None Server 
Instrumentati
on

Y Y Y Y

srvadmin-
isvc

Provides 
systems 
management 
interface to 
local and 
remote 
systems 
management

srvadmin-
deng, 
srvadmin-
omilcore

Server 
Instrumentati
on and 
SNMP 
monitoring

Y Y Y Y

libsmbios Provides 
SMBIOS 
library to get 
standard 
BIOS tables

None Installation 
and software 
updates 
using ITA

Y Y Y Y

smbios-utils-
bin

Provides 
SMBIOS 
Utility to get 
system 
information

None Installation Y Y Y Y

Table 32. Packages needed for local management that are used by GUI and CLI components

RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

srvadmin-
omcommon

Common 
framework 
or libraries 
for GUI/CLI

srvadmin-
omilcore

Server 
Administrato
r GUI/CLI

Y Y Y Y

srvadmin-
omacore

Provides 
plugins that 
act as 
interfaces 
between 
back end 
and GUI/CLI. 
Also 

srvadmin-
omilcore

Server 
Administrato
r GUI/CLI and 
infrastructur
e for 
software 
updates 
using ITA

Y Y Y Y
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RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

provides OM 
CLI tools.

srvadmin-
xmlsup

XML support 
library

None Server 
Administrato
r GUI/CLI

Y Y Y Y

srvadmin-
libxslt

XSLT support 
library * 
Applicable 
on VMware 
ESX only

None Server 
Administrato
r GUI/CLI

Y Y Y Y

srvadmin-cm

NOTE: 
On a 
scripted 
install, 
srvadmin
-cm is 
installed 
on 32bit 
operatin
g 
systems 
only. If 
required 
on a 
64bit 
operatin
g system, 
manually 
install 
the 
same.

Change 
Management 
inventory 
collector. 
Feeds 
software 
inventory 
data to 
management 
station 
applications 
like ITA

srvadmin-
omacore

Software 
inventory & 
updates 
using ITA

Y Y Y Y

Table 33. Server Administrator Web Server (GUI) for Local and Remote Management

RPM Description Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

srvadmin-jre Provides 
JAVA 
Runtime for 
web server

srvadmin-
omilcore

Server 
Administrato
r GUI

Y Y Y* Y

srvadmin-
iws

Server 
Administrato
r Web server 

srvadmin-
omilcore, 
srvadmin-

Server 
Administrato
r GUI

Y Y Y* O***
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RPM Description Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

and GUI 
package

omcommon, 
srvadmin-jre, 
openwsman-
client, 
libwsman1

srvadmin-
tomcat

Server 
Administrato
r Web server

srvadmin-jre, 
srvadmin-
omcommon, 
srvadmin-
omilcore

Server 
Administrato
r GUI

N N N Y

openwsman-
client

Openwsman 
client 
libraries

None Server 
Administrato
r GUI to 
manage 
remote 
nodes using 
WSMAN

Y Y* Y Y

libwsman1 Openwsman 
libraries 
used by 
client and 
server 
components

None Openwsman 
support 
library

Y Y** Y Y

* — Not applicable for OM 7.0 supplemental pack for Citrix Xen 6.0.

** — Should be installed from the OS media for RHEL6 and SLES11.

*** — Obsolete and replaced with srvadmin-tomcat
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Table 34. Server Administrator Remote Enablement (Standard Agent)

RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

srvadmin-
itunnelprovid
er

The Dell 
OpenManag
e Small 
Footprint 
CIM Broker 
(SFCB) 
provider that 
enables 
remote 
management 
of the server

libcmpiCppI
mpl0, 
openwsman-
server, 
sblim-sfcb 
sblim-sfcc

Enabling 
remote 
management 
of server

Y Y Y Y

libwsman1 Openwsman 
libraries 
used by 
client and 
server 
components

None Openwsman 
support 
library

Y Y Y Y

openwsman-
server

Openwsman 
server and 
service 
libraries 
*N/A on 
VMware ESX

None Enabling 
remote 
management 
of server

Y Y* Y Y

sblim-sfcb Small 
Footprint 
CIM Broker 
(sfcb) - CIM 
server 
conforming 
to the CIM 
Operations 
over HTTP 
protocol. 
*N/A on 
VMware ESX

None Enabling 
remote 
management 
of server

Y Y* Y Y

sblim-sfcc Small 
Footprint 
Common 
Information 
Model (CIM) 
Client Library 
(sfcc) 
Runtime 
Libraries 

None Enabling 
remote 
management 
of server

Y Y* Y Y
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RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

*N/A on 
VmWare ESX

libcmpiCppI
mpl0

Provides 
helper library 
to implement 
Common 
Manageabilit
y 
Programmin
g Interface 
(CMPI) C++ 
plugins into 
SFCB *N/A 
on VmWare 
ESX

None Enabling 
remote 
management 
of server

Y Y Y Y

* — Should be installed from the OS media for RHEL6 and SLES11.

Table 35. Storage Instrumentation, SNMP Monitoring, GUI and CLI Plugins

RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

srvadmin-
realssd*
* For Red Hat 
Enterprise 
Linux 6.0 and 
SUSE Linux 
Enterprise 
Server 11

Meta 
package for 
installing 
management 
libraries for 
PCIeSS 
Devices

None Peripheral 
Component 
Interconnect 
Express 
Solid State 
(PCIeSS) 
Devices 
management

N N Y Y

srvadmin-
storage

Core 
interface 
library for 
storage 
management

srvadmin-
deng, 
srvadmin-
isvc, 
srvadmin-
megalib, 
srvadmin-
omilcore, 
srvadmin-
smcommon, 
srvadmin-
storelib

Storage 
instrumentati
on, SNMP 
monitoring 
and CLI (for 
storage 
management
)

Y Y Y Y

srvadmin-
storelib

LSI utility 
libraries for 
storage 
management

srvadmin-
storelib-
sysfs

Storage 
instrumentati
on

Y Y Y Y
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RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

srvadmin-
storelib-
sysfs

Provides 
library for 
interfacing 
with the 
kernel's sys 
filesystem. 
Used by LSI 
storelib 
libraries 
*N/A for 
VMware ESX

None Storage 
instrumentati
on

Y Y Y

srvadmin-
sysfsutils

Provide 
utilities for 
interfacing 
with sysfs 
file system. 
Used by 
OpenManag
e storage 
management 
libraries

None Storage 
instrumentati
on

Y Y Y Y

srvadmin-
megalib 

LSI utility 
libraries for 
storage 
management 
of PERC 4 
controllers. 
*N/A for 64-
bit OMSA 
installation, 
and VMware 
ESX.

None Storage 
instrumentati
on of PERC 4 
controllers

Y Y Y Y

srvadmin-
smcommon

Common 
framework 
or libraries 
for GUI/CLI 
(for storage 
management
)

None Storage 
management 
using Server 
Administrato
r GUI/CLI

Y Y Y Y

srvadmin-
smweb

GUI plugins 
for storage 
management

srvadmin-
omcommon, 
srvadmin-
smcommon

Storage 
management 
using Server 
Administrato
r GUI

Y Y Y** Y

* — Obsolete - merged with srvadmin-storage
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** — Not applicable for OM 7.0 supplemental pack for Citrix Xen 6.0.

Table 36. RAC Instrumentation, SNMP Monitoring, GUI and CLI Plugins

RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

srvadmin-
racsvc

RAC services 
to manage 
DRAC 4

setserial, 
srvadmin-
omilcore

DRAC 4 
instrumentati
on

Y Y Y Y

srvadmin-
rac-
components

RAC data 
populator for 
DRAC 4

None DRAC 4 
instrumentati
on and 
SNMP 
monitoring

Y Y Y Y

srvadmin-
racadm4

Provides CLI 
tools for 
DRAC 4 
administratio
n

None RAC CLI tools 
for DRAC 4

Y Y Y Y

srvadmin-
rac5-
components

RAC Data 
populator for 
DRAC 5

srvadmin-
omilcore, 
srvadmin-
hapi, 
srvadmin-
deng

DRAC 5 
instrumentati
on and 
SNMP 
monitoring

N N N N

srvadmin-
racadm5

Provides CLI 
tools for 
DRAC 5 
administratio
n

srvadmin-
hapi, 
srvadmin-
omilcore

RAC CLI tools 
for DRAC 5

Y Y Y Y

srvadmin-
idrac7

RAC data 
populator for 
iDRAC7

srvadmin-
argtable2, 
srvadmin-
deng, 
srvadmin-
idrac-vmcli, 
srvadmin-
idracadm7, 
srvadmin-
isvc, 
srvadmin-
omcommon, 
srvadmin-
omilcore, 
srvadmin-
rac-
components, 
srvadmin-

iDRAC7 
instrumentati
on and 
SNMP 
monitoring

N N N Y
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RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

racadm4, 
srvadmin-
racdrsc

srvadmin-
idracadm

Provides CLI 
tools for 
iDRAC 
administratio
n

srvadmin-
argtable2, 
srvadmin-
omilcore

RAC CLI tools 
for iDRAC

Y Y Y Y

srvadmin-
idracadm7

Provides CLI 
tools for 
iDRAC7 
administratio
n

srvadmin-
argtable2 
srvadmin-
omilcore

RAC CLI tools 
for iDRAC7

N N N Y

srvadmin-
racdrsc

RAC CLI and 
Web Plugin 
to Server 
Administrato
r for RAC 4, 5 
and iDRAC

None RAC 
management 
using Server 
Administrato
r GUI/CLI

Y Y Y Y

srvadmin-
rac-
components

RAC SNMP 
components 
for RAC 4, 5 
and iDRAC

None RAC 
instrumentati
on and 
SNMP 
monitoring

Y Y Y Y

srvadmin-
rac4-
populator-

RAC Data 
populator for 
DRAC 4

srvadmin-
omilcore

DRAC 4 
instrumentati
on

Y Y Y Y

srvadmin-
argtable2

Library for 
parsing GNU 
style 
command 
line 
argument. 
Used by RAC 
5 and iDRAC 
packages

None RAC CLI tools 
for RAC 5 
and iDRAC 
management

Y Y Y Y

srvadmin-
idrac-ivmcli

Provides CLI 
tools that 
provide 
virtual media 
features 
from the 
management 
station to the 

None RAC CLI tools 
for virtual 
media 
feature

Y Y Y Y
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RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

iDRAC in the 
remote 
modular 
system

srvadmin-
idrac-vmcli

Provides CLI 
tools that 
provide 
virtual media 
features 
from the 
management 
station to the 
iDRAC in the 
remote Rack 
and Tower 
system

None RAC CLI tools 
for virtual 
media 
feature

Y Y Y Y

Table 37. Enable Software inventory and updates using IT Assistant

RPM Description OM 
Dependant 
packages

Required for OpenManage

6.4 6.5 7.0 7.1

srvadmin-cm Change 
management 
inventory 
collector. 
Feeds 
software 
inventory 
data to 
management 
station 
applications 
like ITA

srvadmin-
omacore

Software 
inventory 
and updates 
using ITA

Y Y Y Y
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